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Bienvenido a tu curso 

Revit Structure Acero y Conexiones 

  

Al terminar este curso permitirá a los participantes adquirir destrezas necesarias 

para modelar y editar componentes de acero, definir conexiones estructurales y 

crear familias de componentes estructurales de acero. 

 

Preguntas frecuentes sobre nuestros Cursos Presenciales  

 

Preguntas frecuentes sobre nuestros Cursos Online 

https://youtu.be/ZsW2LRKwdzE
https://youtu.be/jpGtRSkx8nE
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Capítulo 1 
 

Introducción  
 
Conceptos BIM 
 
Revit es una plataforma de diseño y documentación que permite realizar el trabajo de 
diseño, dibujo y creación de tablas de planificación necesario para llevar a cabo el modelado 
de información de construcción (BIM). BIM aporta información sobre el diseño, la 
envergadura, las cantidades y las fases de un proyecto cuando se necesita. 
 
En el modelo de Revit, cada plano de dibujo vista 2D/3D y tabla de planificación es una 
presentación de información proveniente del mismo modelo de construcción virtual. 
Mientras trabaja en el modelo de construcción, Revit recopila información sobre el proyecto 
de construcción y la coordina en las demás representaciones del proyecto. El motor de 
cambios paramétricos de Revit coordina automáticamente los cambios realizados en 
cualquier sitio: en vistas de modelo, planos de dibujo, tablas de planificación, secciones y 
planos. 
 
Building Information Modeling (BIM) 
 
Building Information Modeling (BIM) es un método asistido por software para optimizar la 
planificación, construcción y gestión de edificios. Todos los materiales y datos de 
construcción pertinentes se digitalizan, combinan y enlazan. Esto permite un acceso rápido 
a un gran número de detalles asignados directamente a los materiales instalados. Siguiendo 
la planificación 2D clásica con borradores y planos CAD 3D, BIM agrega una cuarta 
dimensión que contiene varios atributos del producto.  
 
BIM se puede considerar como una mejora de las herramientas simples del CAD 3D y los 
modelos 3D de un edificio. Además de todas las representaciones geométricas del edificio, 
los modelos también pueden contener grandes cantidades de su proyecto y metadatos. 
Éstos pueden ser específicos de proyecto, material y producto, y también se pueden utilizar 
en la gestión de instalaciones. Elementos de construcción "inteligentes" como paredes y 
revestimientos de pisos "conocen" sus propiedades y sus modos de reacción al ambiente 
planificado y a otros materiales relacionados. BIM gestiona automáticamente estas 
relaciones de materiales inteligentes. 
 
Beneficios BIM 
 

1. Captura de la realidad. 
2. El tiempo es oro. 

 

• Menos repeticiones de trabajo y duplicados de dibujos. 

• Modelo con más información que un conjunto de dibujos. 

• Las herramientas de dibujo BIM son más rápidas que las de dibujo 2D, y 
cada objeto está conectado a una base de datos. 
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3. Control en todo momento. 
 

• El flujo de trabajo digital basado en modelos cuenta con funciones como el 
guardado automático o las conexiones con el historial del proyecto; evita que 
se pierdan datos o se dañen archivos 

4. Mejora de la colaboración. 
 

• Los especialistas de c/disciplina pueden acceder a la nube para compartir 
sus modelos de proyecto complejos y coordinar la integración con el resto 
de los profesionales. Gracias a los pasos de revisión y anotación, todos son 
partícipes de la evolución del diseño, de modo que están preparados para la 
ejecución al finalizar el concepto y pasar a la construcción 

5. Simulación y visualización. 
 

• El software saca más partido al análisis y al modelado, sintetizando datos 
para ejecutar con “un solo” botón cálculos rendimientos. 

6. Resolución de conflictos. 
 

• Conductos o las redes eléctricas que pasan por una viga. 
7. Secuenciación de los procedimientos. 

 

• Con un modelo y un conjunto preciso de submodelos para cada fase de la 
construcción, el siguiente paso es una secuenciación coordinada de las 
actividades, los materiales y el personal para conseguir un proceso de 
construcción más eficaz. 

8. Profundización en los detalles. 
 

• El modelo es un magnífico punto de encuentro para la transferencia de 
conocimiento, pero también es necesario compartir planos, secciones y 
alzados tradicionales. 

9. Presentación perfecta. 
 

• Con el diseño completado en una captura que permite modificaciones de la 
realidad, el modelo es la herramienta de comunicación definitiva para 
mostrar el ámbito del proyecto, los pasos que implica y sus resultados. 

10. Disponibilidad en cualquier lugar. 
 

• Detalles del proyecto desde cualquier lugar y en cualquier dispositivo. 
11. Reduce la fragmentación. 
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Interfaz de Usuario 
 

 
 
 

1. Revit Home/ Inicio de Revit. 
2. File Tab / Ficha de Archivo. 
3. Quick Access toolbar / Barra de herramientas de Acceso Rápido. 
4. InfoCenter. 
5. Options Bar / Barra de Opciones. 
6. Properties Palette / Paleta de Propiedades. 
7. Project Browser / Navegador de Proyectos.  
8. Status Bar / Barra de estado. 
9. View Control Bar / Barra de controles de vista. 
10. Drawing Area / Área de Dibujo. 
11. Ribbon / Cinta de Opciones . 

 
 
Revit Home / Inicio de Revit 
 
Se despliega al abrir el programa. Utilizar el Inicio de Revit para localizar crear y abrir todos 
los archivos de los recursos locales o de los proyectos de BIM 360 como proyectos y 
familias, o acceder a las opciones de ayuda. 
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1. Los modelos utilizados recientemente. 
2. Las familias usadas recientemente. 
3. Distintivo que indica que el modelo se ha almacenado en un proyecto de BIM 360. 
4. Controles para abrir otros modelos y familias o para crear otros nuevos mediante 

una plantilla. 
5. Iniciar sesión en cuenta de Autodesk Account. 
6. Acceso a los modelos alojados en BIM 360. 

 
 
File Tab / Pestaña de Archivo 
 
Permite acceder a acciones habituales de archivo como Nuevo, Abrir y Guardar. También 
se puede administrar los archivos mediante herramientas más avanzadas, como 
personalizar las configuraciones de exportación. 
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Quick Access toolbar / Barra de herramientas de Acceso Rápido 
 
La barra de herramientas de acceso rápido contiene un conjunto de herramientas por 
defecto. Es posible personalizar esta barra de herramientas para que muestre las 
herramientas utilizadas con mayor frecuencia. 
 

 
 
 
Para activar o desactivar funciones de Quick Access Bar: 
 

1. Hacer Clic sobre el icono desplegable  
2. Seleccionar el comando que desea mostrar u ocultar en la barra.  

 
Para añadir herramientas a la barra de acceso rápido: 
 

1. Navegar por el Ribbon para visualizar la herramienta que va a requerir. 
2. Hacer Click con el botón derecho en la herramienta y seleccionar “Añadir a barra de 

herramientas de acceso rápido. 
 

 
 
 
IMPORTANTE: Algunas herramientas no se pueden añadir a la barra de herramientas de 
acceso rápido. 
 
Para editar la barra de acceso rápido: 
 

1. Hacer Click derecho sobre la barra y seleccionar “Personalizar barra de 
herramientas de acceso rápido”. 

2. Seleccionar la herramienta en la lista y hacer click en  (Subir) o  (Bajar) 
para desplazar la herramienta a la ubicación deseada. 

3. Seleccionar la herramienta en la lista que desea mostrar encima (a la izquierda si 

vemos la barra de forma horizontal) de la línea de separación y hacer click en 
(Añadir separador). 

4. Seleccionar la herramienta o línea y hacer click en (Eliminar). 
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InfoCenter 
 
Proporciona un conjunto de herramientas que le permiten acceder a fuentes de información 
relacionadas con el producto. 
 

 
 
 
IMPORTANTE: InfoCenter siempre usará Internet Explorer incluso si configura su 
navegador predeterminado con algún otro. 
 
Para utilizar la barra Infocenter: 
 

• Escribir en la casilla seguido del botón “Buscar” para buscar información 
rápidamente en la Ayuda en línea. 
 

 
 

• Iniciar sesión para acceder a los mismos servicios que Autodesk Account, pero con 
los beneficios adicionales de movilidad y colaboración de Autodesk 360. 
 

 
 
 
Options Bar / Barra de Opciones 
 
La barra de opciones se encuentra debajo del Ribbon. Muestra herramientas 
condicionantes que dependen de la herramienta activa o del elemento seleccionado. 
 

 
La barra de opciones la podemos mover encima de la Status Bar o debajo del Ribbon: 
 

1. Hacer Click derecho sobre la barra y seleccione “fijar a parte inferior” y viceversa. 
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Properties Palette / Paleta de Propiedades 
 
La Paleta de Propiedades es un cuadro de diálogo que permite visualizar y modificar los 
parámetros que definen las propiedades de los elementos. 
 

 
 

1. Type Selector / Selector de Tipos 
2. Properties Filter / Filtro de Propiedades 
3. Edit Type button. / Botón de Editar Tipo 
4. Instance Properties / Propiedades de ejemplar (dividido en Parameters Groups / 

Grupos de Parámetros, ej: Constraints, Construction, Dimensions, etc.) 
 

1. Type Selector: Identifica el tipo de familia que está seleccionado y proporciona un 
menú desplegable que permite cambiar de tipo. 
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2. Properties Filter: Debajo del selector de tipo hay un filtro que identifica la categoría 
de los elementos que va a colocar una herramienta o la categoría y el número de 
elementos seleccionados en el área de dibujo. Si se seleccionan varios tipos o 
categorías, la paleta solo muestra las propiedades de ejemplar comunes a todos los 
elementos. 

 

 
 

3. Edit Type Button: A menos que se seleccionen elementos de distintos tipos, el 
botón Editar tipo abre un cuadro de diálogo que permite visualizar y modificar las 
propiedades de tipo del elemento seleccionado (o las propiedades de la vista, según 
se haya configurado el filtro de propiedades). 

4. Instance Properties: Muestra propiedades de ejemplar tanto modificables como de 
solo lectura (sombreadas). Las propiedades son de sólo lectura cuando su valor se 
calcula o asigna automáticamente mediante el software o depende de la 
configuración de otra propiedad. 

 
Desde la Paleta de Propiedades puede efectuar las siguientes acciones: 
 

• Seleccionar el tipo de elemento que va a colocar en el área de dibujo o cambiar el 
tipo de los elementos ya colocados desde el Type Selector. 

• Ver y modificar las propiedades de la vista activa. 

• Acceder a las Type Properties / Propiedades de tipo desde el Edit Type button que 
se aplican a todos los ejemplares de un tipo de elemento. 

 
Si no hay ninguna herramienta de colocación de elementos activa ni ningún elemento 
seleccionado, la paleta muestra las propiedades de la vista activa. También es posible 
acceder a las propiedades de una vista seleccionándola con Click derecho en el Project 
Browser. 
Si cierra la paleta Propiedades, podrá volver a abrirla mediante cualquiera de los métodos 
siguientes: 
 

• En Pestaña Modify → Panel Properties → Properties  

• En Pestaña View → Panel Windows → User Interface 

• Hacer Click derecho en el área de dibujo y seleccionar “Properties” 
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Project Browser / Navegador de proyectos 
 
El Navegador de proyectos muestra una jerarquía lógica de todas las vistas, tablas, planos, 
grupos y otras partes del proyecto actual. Al expandir o contraer una rama, aparecen o se 
ocultan los elementos de niveles inferiores. 
El Project Browser está conformado de varias secciones o grupos que guardan las vistas 
que se generan en el proyecto, algunos de estos grupos son: 
 

• Floor plans / Vistas de planta: se despliegan todos los niveles de los edificios 
(plantas) 

• Ceiling Plans / Vistas de techo: muestra las vistas de entre piso. 

• 3D View / Vistas 3D: despliega las Vistas 3D creadas. 

• Elevations / Fachadas o elevaciones: muestra las vistas de elevación del edificio 
desde Norte, Sur, Este y Oeste. 

• Schedule-Quantities / Listados de cuantificación y materiales: guarda las tablas 
de cuantificación y materiales. 

• Sheets / Planos: guarda las vistas de láminas de impresión creadas en el proyecto 

• Families / Familias: muestra el listado de familias que están cargadas en el 
proyecto 

• Groups / Grupos: guarda los grupos creados en el proyecto 
 
Puede personalizar la organización del Project Browser para ayudarlo a navegar por las 
vistas, planos y tablas de su proyecto. Cuando personaliza el Project Browser, puede 
ordenar las vistas, planos y tablas en grupos o filtrarlas. 
 
Consideraciones: 
 

• Configurar el Navegador de proyectos antes del inicio del proceso de creación del 
modelo. Cuando los usuarios obtienen sus archivos de modelo del BIM Manager ya 
preparado, pasarán menos tiempo en la configuración ellos mismos. 

• Definir las configuraciones organizativas específicas del Navegador de proyectos en 
las plantillas de proyecto 

 
Recomendaciones: 
 

• Cambiar la Organización del navegador para que coincida con las tareas actuales 
de creación de modelos. 

• Usar el navegador de proyectos junto con las Tablas de Vistas para limpiar las vistas 
de trabajo en progreso del usuario. Las vistas de los usuarios, cuando no se 
gestionan, pueden dificultar la navegación del proyecto por parte de otros usuarios 
cuando no entienden el uso de una vista específica. Todas las vistas ocupan espacio 
dentro del modelo del proyecto, lo que posteriormente afectará el rendimiento del 
archivo. 

• Crear dos listas de vistas distintas; uno para vistas de 'trabajo en progreso' (no 
insertadas en planos) y otro para vistas en planos, es decir, “Documentadas”. Este 
enfoque simplificará el mantenimiento y la gestión de las vistas del navegador del 
proyecto. 
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Status Bar / Barra de estado 
 
La barra de estado ofrece consejos y sugerencias sobre qué hacer. Cuando se resalta un 
elemento o un componente, la barra de estado muestra el nombre de la familia y el tipo. 
La barra de estado se encuentra en la parte inferior de la ventana de la aplicación. 
 

 
 

• Worksets : permite el acceso rápido al cuadro de diálogo Worksets 
(Subproyectos) de un modelo compartido. 

• Editing Requests : para los modelos compartidos, indica el número de 
solicitudes de edición que están pendientes. 

• Design Options : permite acceso rápido al cuadro de diálogo Design Options. 

• Select Links : permite seleccionar un archivo vinculado y sus elementos 

• Select Underlay elements : permite seleccionar elementos que están debajo 
de la vista 

• Select Pinned elements : permite seleccionar elementos que están bloquados 

• Select Element by face : permite seleccionar elementos por caras 

• Drag elements on Selection : activada permite desplazar elementos sin que 
los haya seleccionado previamente (al estar resaltados se podrán desplazar) 

• Filter : muestra el cuadro de dialogo Filter que permite refinar la selección por 
categoría. 

• Exclude Options: esta opción permite excluir de una selección todos los 
componentes que son parte de una opción de diseño (para que esta opción se active 
es necesario tener creadas opciones de diseño). 

Editable Only: genera un filtro de selección que permite seleccionar solo los componentes 
de un workset Editable (esta función sólo se muestra cuando se está trabajando con 
worksets). 
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View Control Bar / Barra de controles de vista 
 
La barra de controles de vista se encuentra en la parte inferior de la ventana de la vista, 
encima de la barra de estado, e incluye las siguientes herramientas: 
 

 
 

• Scale : La escala de vista es el sistema proporcional utilizado para 
representar objetos en un dibujo. Esta se puede personalizar a otra escala que no 
este señalada en la lista desplegable, en la parte superior. 
 

 
 

• Detail Level : Una columna se puede mostrar de forma diferente según el nivel 
de detalle: Coarse (bajo), Medium (medio) o Fine (alto). Esto se predefine en la 
misma familia. Ej. 
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• Visual Style : Puede especificar múltiples estilos de gráficos para una vista de 
proyecto. Los estilos visuales se agrupan en model display, shadows, lighting, 
photographic exposure, y background. 
El estilo visual se puede cambiar en la primera lista desplegable o desde el apartado 
de Model Display en Graphic Display Options, como se muestra acontinuación.  

 

 
 

o Wireframe: Muestra la imagen del modelo con todos los bordes y líneas 
dibujados, pero sin las superficies. 
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o Hidden Line: Muestra la imagen con todos los bordes y líneas dibujados, 
excepto los obstruidos por superficies. 
 

 
 

o Shaded: Muestra la imagen en modo sombreado y permite mostrar luz 
indirecta y sus sombras. Seleccione Show Ambient Shadows en el cuadro 
de diálogo Graphic Display Options visto anteriormentede gráficos para 
simular el bloqueo de la luz ambiental. 
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o Consistent Colors: Muestra la imagen con todas las superficies 
sombreadas según la configuración de color de sus materiales. 
 

 
 

o Realistic: Muestra las apariencias de material en vistas editables. 
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o Ray Trace: Es un modo de renderización fotorrealista que permite aplicar 
zoom y encuadrar el modelo. Cuando se utiliza este estilo visual, la 
renderización del modelo comienza en una resolución baja, pero se aumenta 
rápidamente la fidelidad para que sea más fotorrealista. Puede definir 
“lighting”, “photographic exposure”, y “background”, en el cuadro de diálogo 
Graphic Display Options. 
 

 
 
 

• Sun Path On/Off : Tanto Sun Path y Shadows se complementan para generar 
mucha más información sobre la iluminación natural del proyecto, por lo tanto active 
ambas y de esta forma obtendrá mejores resultados para estudiar el efecto de la luz 
y las sombras en un edificio. 
Al activar esta opción le permitira elegir si crear: 

 
o Condiciones de iluminación según la ubicación del proyecto, la fecha y la 

hora. 
o Condiciones que tal vez no existan en el mundo real. 

• Shadows On/Off : Se pueden encender las sombras con este comando o 
desde el cuadro de diálogo Graphic Display Options. 

• Show/Hide Rendering : (Disponible solo cuando el área de dibujo muestra 
una vista 3D) Antes de renderizar una vista 3D, defina los parámetros que controlan 
la iluminación, la exposición, la resolución, el fondo y la calidad de la imagen. 

• Crop View : La región de recorte define los contornos de una vista de proyecto. 
También para trabajar con regiones de recorte puede: 
 

o Crear regiones de recorte poligonales. 
o Mostrar u ocultar regiones de recorte de modelo y anotación. 
o Cambiar el tamaño de las regiones de recorte. 
 

• Show/Hide Crop Region : Puede mostrar u ocultar regiones de recorte según 
sea necesario. 
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• Unlocked/Locked 3D View : Puede bloquear la orientación de una vista 3D 
para etiquetar elementos y añadir key notes (notas clave) en la vista. Al hacer click 
en la herramienta se deseplegarán las siguientes opciones. 
 

 
 

o Save Orientation and Lock View : Bloquea la vista en la orientación 
actual. No se puede orbitar el modelo en este modo. 

o Restore Orientation and Lock View : Restituye la orientación bloqueada 
que tenía previamente una vista. Se mostrarán las etiquetas y las key notes 
colocadas en la orientación original. 

o Unlock View : Desbloquea la orientación actual, lo que permite navegar y 
orbitar la vista 3D. Si hay etiquetas o notas clave colocadas en la vista, no 
se mostrarán hasta que haga clic en el comando Restore Orientation y Lock 
View. 

 

• Temporary View Properties : Oculta o aisla elementos o categorías de 
elementos temporalmente a fin de ver o editar solo algunos elementos de una 
categoría concreta de una vista. Al hacer click en la herramienta se deseplegarán 
las siguientes opciones. 

 

 
 

o Isolate Category: Por ejemplo, si selecciona algunos muros y puertas, solo 
los muros y las puertas permanecerán visibles en la vista. 

o Hide Category: Oculta todas las categorías seleccionadas en la vista. Por 
ejemplo, si selecciona algunos muros y puertas, todos los muros y las 
puertas se ocultarán en la vista. 

o Isolate Element: Aísla solo los elementos seleccionados. 
o Hide Element: Oculta solo los elementos seleccionados. 
 
Nota:. Al ocultar temporalmente un elemento o una categoría de elemento, el 
icono Aislar/Ocultar temporalmente se muestra con un borde ( ). 
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• Reveal Hidden Elements : Permite visualizar a los elementos ocultos de forma 
temporal o mostrarlos permanentemente. 
 
Para mostrar elementos ocultos: 
 

1. Con la herramienta activada seleccionar el elemento que desea mostrar. 
2. Seguir la siguiente ruta: 

 
▪ Pestaña Modify → Panel Reveal Hidden Elements → Unhide Element 

/ Category 
 

 
 

• Worksharing Display : (Solo está disponible cuando el proyecto ha sido 
compartido) facilita la identificación visual de elementos compartidos en un proyecto. 
 
Estos modos de visualización se pueden utilizar para mostrar: 
 

 
 

o Check Status: El estado de propiedad de los elementos. 
o Owners: Los propietarios de elementos. 
o Model Updates: Elementos que no están sincronizados con el modelo 

central oque se han suprimido en dicho modelo, 
o Worksets: Elementos asignados a Worksets predeterminados. 
 
Nota: Los colores de visualización se pueden editar desde la opción 
“Worksharing Display Settings”. 
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• Temporary View Properties : Permite realizar un cambio temporal en la 
visibilidad y los gráficos de una vista sin que esto afecte a la configuración de la 
plantilla. Seleccione la herramienta para mostrar un alista de las opciones de 
visualización disponibles. 
 

 
 

o Enable Temporary View Properties: Seleccionar esta opción para 
especificar el modo de vista temporal. Los cambios realizados en las 
propiedades de la vista serán visibles hasta que se selecciona “Restore View 
Properties”. 

o Temporarily Apply Template Properties: Seleccionar esta opción para 
asignar o crear una plantilla de vista. 

o Recent Templates: Muestra una lista de las últimas 5 plantillas de vista que 
ha utilizado. Seleccione una plantilla si desea volver a aplicarla a una vista 
temporal. 

o Restore View Properties: Seleccionar esta opción para cerrar el modo de 
vista temporal y mostrar la vista de proyecto activa. 

 

• Show/Hide the Analytical Model : Puede visualizar el modelo analítico en 
cualquier vista. Al activar la herramienta muestra  la configuración del modelo 
analítico según lo especificado en el cuadro de diálogo Visibility/Graphics. 

• Highlight Displacement Sets : En una vista desplazada (Displaced View) 
resalta los elementos desplazados para la comprensión del diseño. Ej. 
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• Reveal Constraints : Permite ver rápidamente todas las restricciones de 
alineación y restricción de cotas en la vista. 

 
Nota: Las restricciones creadas en boceto (sketch) se muestran en un color más 
claro como se muestra en la siguiente imagen. 

 

 

• Preview Visibility : (Disponible en el Editor de Familias) Permite visualizar una 
vista previa de los efectos de la configuración de visibilidad y los parámetros de 
geometría de una familia sin salir del Editor de familias. 

 
Drawing Area / Área de dibujo 
 
Las ventanas del área de dibujo de Revit se denominan vistas. Cada vez que se abre una 
vista en un proyecto, por defecto esta se despliega en el área de dibujo. Las vistas muestran 
la geometría del modelo tanto en 2D como 3D, además de los planos y los listados de 
cuantificación. 
 
Cada vez que se abre una vista se activa una pestaña (tab) que se muestra en la parte 
superior de la ventana de dibujo. Para pasar de una vista a otra, se debe hacer clic sobre 
la pestaña que corresponda al nombre de la vista que se quiere activar. 
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Para gestionar sus vistas en el área de dibujo puede seguir la siguiente ruta Pestaña View 
→ Panel Windows donde encontrará las siguientes herramientas: 
 

 
 

• Switch Windows: Permite visualizar otra vista abierta (pero oculta) en el área de 
dibujo. 

• Close Inactive: Cierra todas las vistas abiertas, excepto la vista activa. 

• Tab Views: Organiza todas las vistas como fichas en una ventana del área de 
dibujo. 

Tile Views: Permite ver todas las vistas abiertas a la vez. 
 
 
Ribbon / Cinta de Opciones 
 
Proporciona todas las herramientas necesarias para crear un proyecto o una familia. Se 
compone de la siguiente forma: 
 

 
1. Tabs (Fichas) 
2. Panel (Paneles) 
3. Tools / Controls (Herramientas y Controles) 
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Tipos de Objetos en Revit 
 
Existen tres tipos de elementos definidos en Revit:  
 

1. Modelo 
2. Referencia (Datum) 
3. Específicos de vista 

 
Elementos de modelo 
 
Representan toda la geometría 3D real de un edificio. Aparecen en vistas relevantes del 
modelo. Ejemplos; Muros, ventanas, puertas, cubiertas, Muros estructurales, losas, rampas. 
Mobiliarios o equipos como; fregaderos, calderas, conductos, rociadores y paneles 
eléctricos. 
 
A su vez los elementos modelo se clasifican en dos tipos de elementos: 
  

• Anfitriones (host):  estos son los elementos construidos en el sitio de la 
construcción. Por ejemplo: Muros, techos, cubiertas, muros estructurales. 

 
Componentes de modelo, éstos son todos los demás tipos de elementos en el modelo de 
construcción. Por ejemplo: ventanas, puertas, armarios, vigas, columnas estructurales, etc. 
 
Elementos de referencia 
 
Definen el contexto del proyecto. Estos elementos son; ejes, niveles y niveles de referencia. 
 
Elementos específicos de vista 
 
Aparecen solo en las vistas en que se crearon. Son útiles para describir o documentar un 
modelo. Las cotas, tags, textos son ejemplos de específicos de vista. Los elementos 
específicos de vista se clasifican en: 
 
 

• Elementos de anotación: componentes 2D que documentan el modelo y 
mantiene la escala en papel. Por ejemplo; cotas, etiquetas y notas clave son 
ejemplos de elementos de anotación.  

 

• Detalles: elementos 2D que proporcionan detalles sobre el modelo de 
construcción en una vista particular. Líneas de detalle, regiones rellenadas y 
componentes de detalle 2D son ejemplos de detalles.  
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Diagrama elementos en Revit 
 

 
 
IMPORTANTE: Todos los elementos en Revit están organizados por categorías, familias y 
tipos. 
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Tipos de familias 
 
Todo lo que se crea en Revit es parte de una familia (Revit Family); en consecuencia, 
comprender a las familias y lo que se necesita para manipularlas es una parte vital del 
aprendizaje del software. Comenzando con la diferencia entre las familias de sistema y 
componentes y el uso de las plantillas de familias (Family Template). 
 
Los tres tipos de familia en Revit son: familias de sistema, familias cargables y familias de 
sitio. 
 

TIPO DE FAMILIA CARACTERÍSTICAS 

Familia de Sistema No están disponibles para ser creadas o 
cargadas como archivos separados del 
proyecto de forma predefinida Revit ya 
tiene configurados un conjunto de 
propiedades y la representación gráfica 
puede usar los tipos predefinidos y/o 
generar nuevos tipos dentro del proyecto o 
plantilla. 
 
Nota: Las familias de sistema pueden ser 
transferidos entre proyectos desde: 
 
Pestaña Manage → Panel Settings → 
Transfer Project Standards. 
 

Familias Cargables Son aquellas que se pueden cargar al 
proyecto y son creadas a partir de plantillas 
de familia. Se puede determinar un 
conjunto de propiedades y la 
representación gráfica. Estas familias están 
definidas en archivos con extensión *.RFA 
y son independientes al proyecto. Ejemplos 
de familias cargables son: puertas, 
ventanas, mobiliario, columnas, vigas, etc. 

Familias In Situ Define elementos personalizados que se 
crean en el contexto del proyecto las 
familias en sitio se generan cuando se 
necesita una geometría única para el 
proyecto, es decir que no será usada para 
otros proyectos. Debido a que el uso de 
estas familias es limitado, solo contienen un 
tipo, pero pueden ser copiadas varias veces 
en el mismo proyecto. 
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Tipos de Plantillas de Familias 
 
Si bien la mayoría de las plantillas de familias se nombran de acuerdo con el tipo de familia 
de elementos creada a partir de ellas, Ej. “Metric Structural Column” para columnas 
estructurales; hay una serie de plantillas que incluyen uno de los siguientes descriptores 
después del nombre de la familia: 
 

• Basada en muro (Wall-based) 

• Basada en techo (Ceiling-based) 

• Basada en suelo (Floor-based) 

• Basada en cubierta (Roof based) 

• Basada en línea (Line based) 

• Basada en cara (Face based) 
 
Wall-based, ceiling-based, floor-based y roof-based son conocidas como “plantillas basadas 
en anfitrión” (host-based templates). Una familia basada en anfitrión solo se puede colocar 
en un proyecto si contiene un elemento de su tipo de anfitrión. También se les puede incluir 
huecos para cortar el anfitrión una vez colocado en él 
 

PLANTILLA DESCRIPCIÓN 

Basadas en muro Para crear componentes que se insertarán 
en muros. Hay componentes de muro 
(como puertas y ventanas). Estas plantillas 
tienen un muro, necesario para mostrar 
cómo encaja el componente en él. 

Basadas en techo Para crear componentes que se insertarán 
en techos. Algunos ejemplos de familias 
basadas en techo son los aspersores 
automáticos y las luminarias empotradas. 

Basadas en suelo Para componentes que se insertarán en 
suelos. Hay componentes de suelo (por 
ejemplo, rejillas de calefacción). 

Basadas en cubierta Para componentes que se insertarán en 
cubiertas. Las claraboyas y los ventiladores 
de techo son ejemplos de familias basadas 
en cubiertas. 

Basadas en línea Para crear familias de modelos y detalles 
que utilicen 2 puntos de colocación. 

Basada en cara Para crear familias basadas en un plano de 
trabajo, pueden cambiar sus hosts, hacer 
cortes complejos en los hosts y se pueden 
colocar en cualquier superficie, 
independientemente de su orientación. 
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PLANTILLA DESCRIPCIÓN 

Independientes Para componentes que no dependen de un 
anfitrión. Un componente independiente se 
puede colocar en cualquier lugar de un 
modelo y puede estar acotado por otro 
componente independiente o por 
componentes basados en un anfitrión. Ej. 
mobiliario, accesorios, los conductos y las 
uniones (fittings). 

Adaptativas Para crear componentes que necesiten 
adaptarse con flexibilidad a muchas 
condiciones contextuales únicas. Por 
ejemplo, los componentes adaptativos 
podrían usarse en sistemas repetitivos 
generados mediante la disposición de 
múltiples componentes que cumplen con 
las restricciones definidas por el usuario. 
Cuando selecciona una plantilla adaptativa, 
está creando una familia de masas 
utilizando un editor de familias especial en 
el entorno de diseño conceptual. 

Especialidad Use una plantilla especial cuando la familia 
requiera una interacción única con el 
modelo. Estas plantillas de familias son 
específicas para un solo tipo de familia. 
Por ejemplo, la plantilla de “Armazón 
Estructural” (Structural Framing) solo se 
puede usar para crear contenido de 
armazones estructurales. 

 
No limite la categoría del elemento a la plantilla elegida. Puede seleccionar el tipo de 
anfitrión (host) en la plantilla y después cambiar la categoría que necesita desde: 
 

Pestaña Tab → Panel Properties → Herramienta Family Category and Parameters  
 
 
Adicionalmente algunos tipos de familias requieren una plantilla para funcionar 
apropiadamente. 
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Parámetros 
 
Prácticamente todos los elementos dentro del entorno de Revit utilizan parámetros para su 
definición, estos comprenden dos tipos fundamentales que existen dentro del entorno de 
Revit; Type Parameters (Parámetros de tipo) e Instance Parameters (Parámetros de 
instancia). Ambas son contenedores de valores. Los parámetros de tipo afectan a todas las 
familias asociadas que se han colocado dentro de un entorno de proyecto, mientras que los 
parámetros de instancia afectan solo a una instancia de familia particular cuando se 
selecciona y modifica en la paleta Propiedades. Los parámetros Tipo e Instancia pueden 
definirse directamente dentro del proyecto como Parámetros del proyecto, o cargarse al 
proyecto como Parámetros compartidos. Existe un tercer punto de definición de parámetro, 
que es Parámetros globales, los parámetros globales se definen dentro del entorno del 
proyecto. En las siguientes secciones, cada una de estas; Los parámetros Proyecto, 
Compartido y Global se describen con más detalle. 
 
Project Parameters 
 
Los parámetros del proyecto agregan campos de datos de información personalizados al 
modelo, a la información analítica e información del proyecto. Un usuario puede usar los 
parámetros del proyecto para las familias del sistema que están integradas en el entorno 
del proyecto (por ejemplo, paredes, pisos) además de agregar más propiedades a las 
familias cargables, una vez que se colocan en el proyecto. 
 
Para crear parámetros de proyecto: 
 

1. Ir a la Pestaña Manage → Panel Settings → Project Parameters. 
2. Elegir el Parámetro disponible necesario y dar Click en “OK”, o crear uno nuevo al 

hacer Click en “Add”. 
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3. Definir el tipo de parámetro entre Project Parameter (Puede aparecer en tablas, pero 
no en tags / etiquetas) o Shared Parameter (Puede utilizarse en múltiples proyectos 
y familias, se muestra en tablas y etiquetas), en la sección Parameter Type.. 

4. Definir en la sección de Parameter Data lo siguiente: 
a. Nombre del parámetro, disciplina, tipo de parámetro y Grupo de parámetro. 
b. Descripción de parámetro en el Tooltip 
c. Si el parámetro es de Tipo o de Instancia 

5. En la sección Categories seleccionar la categoría de elemento al que se le asignará 
el parámetro creado. 

6. Una vez terminada la configuración del parámetro de proyecto hacer click en “OK”. 
 

 
 
Los Parámetros del Proyecto, aunque están disponibles para las tablas dentro del proyecto 
para las categorías de elementos seleccionadas, no están disponibles para los elementos 
de anotación como Etiquetas que representan los datos de propiedad del elemento, cuando 
se encuentran en una vista. Al igual que con los proyectos, los parámetros personalizados 
también se pueden agregar directamente a los elementos dentro del editor de familias, 
imitando efectivamente los parámetros del proyecto, a estos se los conoce más 
comúnmente como Family Parameters, estos parámetros son visibles cuando la familia se 
carga y se coloca en el proyecto. 
 
Consideraciones: 
 

• Los parámetros del proyecto se agregan a nivel de categoría y se pueden agregar 
a varias categorías. 

• Los parámetros del proyecto se gestionan internamente dentro del proyecto Revit. 

• Los parámetros del proyecto pueden usarse en filtros gráficos de visibilidad. 

• Los parámetros del proyecto no se pueden usar para etiquetar, pero pueden 
aparecer en tablas. 
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Shared Parameters 
 
Los parámetros compartidos son definiciones de parámetros, almacenados externamente 
al proyecto y a los archivos de familia que se pueden agregar a ambos, la información 
compartida puede reflejarse en todos los elementos del proyecto, y visualizarse en tablas y 
etiquetas. 
 
La definición de parámetros como parámetros compartidos tiene el beneficio de no solo 
permitir que las familias cargables reconozcan los valores de los parámetros 
correspondientes dentro del proyecto, sino que también mantiene la coherencia entre 
múltiples proyectos / familias. Esto asegura que los valores puedan ser reportados o 
extraídos consistentemente de múltiples proyectos. 
 
Las definiciones de parámetros compartidos se almacenan en un archivo de texto externo 
(TXT) independiente de cualquier archivo de familias o proyecto de Revit. Esto permite a 
los usuarios acceder al archivo desde diferentes familias o proyectos. 
 
Consideraciones: 
 

• Es fundamental establecer y mantener un régimen estricto para la gestión de 
archivos de parámetros compartidos. Esto garantizará la coherencia de las 
definiciones de parámetros en múltiples proyectos, plantillas de proyectos y archivos 
familiares. Garantizar que los elementos se puedan estandarizar y compartir entre 
archivos de proyecto y archivos de plantilla. Esta estandarización de las definiciones 
de parámetros garantizará que las familias o el contenido puedan reutilizar los 
campos preexistentes sin confusión ni incertidumbre. 

• La información definida en el valor del parámetro en una familia o proyecto que usa 
un parámetro compartido no se aplica automáticamente a otra familia o proyecto 
que usa el mismo nombre de parámetro compartido. 

• Los parámetros compartidos pueden ser parámetros de tipo (cada puerta obtendrá 
el mismo valor para la resistencia al fuego) o parámetros de instancia (cada puerta 
puede tener su propio valor para la resistencia al fuego). 

• Los parámetros definidos en el archivo de parámetros compartidos no pueden 
modificarse. es decir, sus propiedades no se pueden modificar, solo se pueden 
eliminar y volver a crear. 

 
Global Parameters 
 
Los parámetros globales se definen dentro del entorno del proyecto. Los parámetros 
globales pueden usarse efectivamente para lo siguiente: 
 

• Asociar el valor a una dimensión o restricción. 

• Estar asociado a una instancia de elemento o propiedad de tipo  

• Asociar con un parámetro de instancia o un parámetro de tipo. 

• Puede informar el valor de una dimensión y usar su valor dentro de fórmulas de 
otros parámetros globales, como se muestra a continuación: 
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Consideraciones: 
 

• Los parámetros globales deben usarse con moderación para aprovechar al máximo 
el modelo. 

• Los parámetros globales no son accesibles para las tablas. 

• Cualquier parámetro que se cree (Proyecto, Compartido o Global) requiere que su 
Disciplina y Tipo se definan correctamente si se van a utilizar de manera efectiva, 
sin errores. Tenga en cuenta que las listas de agrupación de parámetros para 
Disciplina y Tipo no son accesibles para el usuario y no se pueden agregar ni 
modificar. 

• Las convenciones de nomenclatura de la compañía para los parámetros son críticas 
para garantizar la coherencia entre los proyectos. 

 
Recomendaciones: 
 

• Utilizar la descripción de la información “Tooltip” sobre herramientas para aportar 
más claridad al uso y la función del parámetro. Tenga en cuenta que esta 
descripción está limitada a 250 caracteres. 

• Evitar el uso de nombres de grupo ambiguos como 'General': esto generalmente 
puede causar confusión al ubicar y crear parámetros y, posiblemente, causar la 
duplicación de las definiciones de parámetros (nombre). 

• Donde los valores de los parámetros potencialmente abarcan múltiples disciplinas; 
Esto es típico de las definiciones dimensionales. Considere la convención de 
nomenclatura ligeramente más flexible; por ejemplo, 'Ancho' podría abarcar el 
Ancho de una placa base, el Ancho del cartabón o el Ancho de la placa inferior de 
un ancla. 

• Definir claramente una estrategia sobre cómo y cuándo se deben usar, crear y 
cambiar definiciones de parámetros compartidos de la compañía y cómo los 
usuarios pueden y deben cambiar el archivo de parámetros compartidos adjuntos 
de las sesiones para acomodarlos. 

• Usar Multicategory Schedules (Tablas de multi-categoría) para enumerar diferentes 
familias que contienen el mismo parámetro compartido. 
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Transferir Parámetros de proyecto 
 
La herramienta Transferir Estándares de proyecto requiere que se abra un archivo de Revit 
(RVT / RTE / RFA) en segundo plano, es decir, dos archivos se abren simultáneamente en 
la misma sesión de Revit. Se recomienda que en todos los usos de la herramienta Transferir 
Estándares de proyecto se utilice la opción Check None. Luego transfiera selectivamente 
los estándares requeridos. 
 
No es inusual cuando se transfieren estándares que aparezca el cuadro de diálogo de 
advertencia cuando la operación intenta sobrescribir las configuraciones existentes. Leer la 
información en el cuadro de diálogo para determinar la acción correcta. 
 
Se recomienda que cuando se inicia un proyecto, la plantilla que se utiliza para iniciar el 
proyecto se guarde y se archive en una ubicación de solo lectura. Esto es para evitar que 
se editen inadvertidamente, y también para poder saber qué plantilla se usó para iniciar un 
archivo de proyecto, en caso de que ocurra algún problema y tener una copia de la plantilla 
original puede ayudar a identificar la causa. 
 
Los estándares de proyecto incluyen: 
 

• Tipos de familia (incluidas las familias de sistema, pero no las familias cargadas) 

• Parámetros globales (si al transferir los parámetros globales hay otros con el mismo 
nombre en el proyecto de destino, se les añade un número [1] para indicar el 
duplicado) 

• Grosores de línea, materiales, plantillas de vista y estilos de objeto 

• Configuración mecánica, tuberías y configuración eléctrica 

• Estilos de anotación, esquemas de relleno de color, y patrones de relleno 

• Configuración de impresión 
 
Para transferir los estándares de proyecto: 
 

1. Abrir ambos archivos, el archivo con los estándares y el archivo que los recibirá. 

2. Ir a la Pestaña Manage → Panel Settings → Transfer Project Standards  
3. En el cuadro de Diálogo Select Items to Copy, seleccione el proyecto de origen en 

Copy From. 
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4. Seleccionar los estándares de proyecto deseados. Para seleccionar todos los 
estándares de proyecto, hacer clock en Check All. 

5. Hacer Click en OK. 
6. Si se abre el cuadro de Diálogo Duplicate Types: 

 

 
 
a. Overwrite: Transfiere todos los estándares nuevos y sobrescribe los tipos 

duplicados 
b. New Only: Transfiere todos los estándares de proyecto nuevos y omite los 

tipos duplicados. 
c. Cancelar: Cancela la operación. 
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Control de Visibilidad en vistas 
 
En Revit, la visualización de elementos se controla mediante una serie de factores. Los 
estilos de objeto (Object Styles) del proyecto y las modificaciones de visibilidad y gráficos 
(Visibility and Graphics) de la vista son los controles principales que permiten modificar la 
visualización de objetos. 
 
Control de Propiedades de las Categorías en vistas 
 
Los estilos de objeto son muy similares a las capas o niveles en el software CAD. Se puede 
acceder a ellos desde: 
 

• Pestaña Manage → Panel Settings → Object Styles. 

 
 

Los estilos de objeto especifican el grosor de línea (Line Weight), el patrón de línea (Line 
Pattern), el color de línea (Line Color) y los materiales para los elementos de modelo, 
anotación, analíticos e importados dentro de Revit. Estos estilos de objeto también pueden 
contener subcategorías para ramificar aún más los componentes de un objeto en una vista. 
Las propiedades de vista de los objetos se establecen primero globalmente, pero luego se 
pueden ajustar vista por vista. 
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La apariencia de los objetos también está controlada por el Nivel de detalle de una vista. 
 
Ejemplo: 
 

Las trabes pueden aparecer como una sola línea o los bordes de la geometría según 
el nivel de detalle de la vista que se aplica. 

 
Hay subcategorías de estilos de objeto para controlar la visibilidad y los gráficos de partes 
del objeto. Los estilos de objeto se pueden asignar para exportar a capas o niveles 
específicos a otro software CAD. El uso de subcategorías es especialmente útil para asignar 
estilos de objetos a capas o niveles. 
 
Consideraciones: 
 

• Los estilos de objeto se aplican a todas las vistas. 

• La creación de una subcategoría en una familia también se importará al proyecto 
después de su inserción. Es importante que el BIM Manager organice una buena 
convención de nomenclatura. 

• Los nombres de subcategorías distinguen entre mayúsculas y minúsculas (p. Ej.: 
Radiador no es lo mismo que radiador). 

• Incluso si modifica en el editor de familia para categorías o subcategorías, la 
proyección de grosor de línea, corte o color de línea, patrón de línea, cuando lo 
importe en el proyecto, se mantendrá la definición de estilos de objeto del proyecto. 

• No es posible eliminar o cambiar el nombre de una categoría o subcategoría 
incorporada. 

• Los filtros y los sistemas de conductos / tuberías anularán los estilos de objetos 
o Filtros en la vista donde se agregó 
o Sistemas en todo el proyecto 
o Nota: Los filtros tienen prioridad sobre los sistemas en las vistas donde se 

agregó 
 
Visibitity and Graphics (Vista por vista) 
 
Controla la visibilidad y la presentación de gráficos de elementos de modelo, elementos de 
referencia y elementos específicos de vista para cada vista de un proyecto. 
 
Se puede acceder al control de visibilidad y gráficos con cualquiera de las siguientes rutas: 
 

• Pestaña View → Panel Graphics → Visibility / Graphics 

• Paleta de Propiedades → Grupo Graphics → Visibility / Graphics 
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Se puede usar para controlar la visibilidad de las categorías, la visibilidad de líneas, 
patrones, transparencia, medio tono y nivel de detalle de las categorías y subcategorías 
respectivamente; de categorías de modelo, anotación, modelo analítico e importados. 
También  
 
Los parámetros que se modifican son los especificados en el nivel del proyecto. La 
configuración del nivel del proyecto se realiza en el cuadro de Object Styles mencionado 
anteriormente. 
 
Creación de Filtros para manejar la visibilidad y propiedades de los objetos 
 
Los filtros de vista se usan invariablemente junto con las plantillas de vista para definir los 
entregables del proyecto, es decir, Planos y Vistas asociadas. Se utilizan para controlar la 
apariencia (o no apariencia) de elementos dentro de la vista, o más frecuentemente, en un 
valor de parámetro asociado con el elemento. Se puede acceder a ellos con cualquiera de 
las siguientes rutas: 
 

• Pestaña View → Panel Graphics → Filters. 

• Pestaña View → Panel Graphics → Visibility / Graphics → Filters 
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Los filtros se basan en reglas o conjuntos de reglas, cada conjunto de reglas utiliza la 
condición AND u OR: 
 

 
 

• AND: Todas las reglas y conjuntos de reglas anidados dentro de este conjunto 
deben evaluarse como verdaderos. 

• OR: Una o varias reglas o conjuntos de reglas anidados dentro de este conjunto 
deben evaluarse como verdaderos. 

 
Cuando las reglas de filtros incluyen conjuntos de reglas anidados, utilice las condiciones 
AND y OR cuidadosamente, en el orden correcto y con el anidamiento adecuado. 
En algunos resultados, debe utilizar AND con una condición OR anidada. En otros 
resultados, debe utilizar OR con una condición AND anidada. Los resultados pueden variar 
en gran medida, y debe asegurarse de usar las reglas de filtro adecuadas para lograr sus 
objetivos. 
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Consideraciones: 
 

• Convenciones de nomenclatura que proporcionan una indicación descriptiva clara 
de para qué se utilizará el filtro de vista, ya que no hay disponible un campo 
descriptivo / comentario adicional. 

• La configuración del filtro de vista anulará todas las configuraciones de estilo de 
objeto para la vista donde se aplique. 

 
Recomendaciones: 
 

• Utilizar los filtros de vista para agregar color / patrones a los elementos del modelo 
para proporcionar una mejor claridad a las vistas de diseño. 

• Utilizar los filtros de vista junto con las Plantillas de vista para obtener un mejor 
control y garantizar la coherencia en las vistas en los planos documentados. 

 
Con la información vista anteriormente estas son las consideraciones y recomendaciones 
generales para el control de visibilidad y gráficos del proyecto. 
 
Consideraciones: 
 

• Mediante el cuadro de diálogo visibilidad / gráficos o en una selección de elemento 
en una vista se anularán cualquier configuración aplicada a través de los estilos de 
objeto. 

• Ajustar las vistas de forma individual puede llevar mucho tiempo y ser propenso a 
incoherencias cuando se ve en varias vistas. Considere la posibilidad de definir 
ajustes que pueden o se utilizarán varias veces en una plantilla de vista. 

• Con respecto a la visualización gráfica de elementos de modelo individuales, existe 
una jerarquía predeterminada de anulaciones, cuyo orden aproximado es el 
siguiente, si se aplicaran todas las anulaciones. Tenga en cuenta que esto es para 
anulaciones gráficas, no visibilidad: 
 

1. Estilos de objeto 
2. Sistema MEP (Los gráficos de sistema solo tendrán prioridad sobre el 

siguiente) 
3. Visibilidad / Gráficos de vista (categoría de elemento) 
4. Filtros de vista (líneas y patrones) 
5. Anulaciones del elemento individual. (Override graphics in View by 

Elements) 
 
Recomendaciones: 
 

• Utilizar las plantillas de vista junto con los filtros de vista como base para el control 
de visualización de la vista. 

• Evitar el uso del control de elementos individuales (gráficos o visibilidad) cuando sea 
posible, aunque es útil (y a veces inevitable) para vistas documentadas, es bastante 
difícil para otros usuarios del archivo del proyecto interpretar y comprender el 
contexto en el que se ha utilizado. 

• Cuando se va a ejercer un mayor grado de control en una vista, se recomienda el 
uso de filtros de vista, ya que estos pueden ser impulsados por categorías y / o 
parámetros. 
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Manejo de Snaps 
 
Al colocar un elemento o crear un boceto de una línea, utilice los “Snaps” para lograr la 
alineación con la geometría existente. Se puede acceder a la configuración de los Snaps 
desde: 
 
Pestaña Manage → Panel Settings → Snaps. 
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En esta pestaña puede configurar lo siguiente: 
 

• Snaps Off: Para desactivar todos los Snaps 

• Length / Angular dimensions snap increments: A medida que cambia el nivel de 
zoom en una vista, los incrementos de ajuste cambian. Cuando se acerca, los 
incrementos de ajuste son más pequeños. Cuando se aleja, los incrementos de 
ajuste son mayores. Defina incrementos de ajuste para longitudes y ángulos de 
dimensión que se adapten a sus necesidades. Separe los valores con punto y coma. 

• Object Snaps: Seleccionar las casillas de verificación para habilitar las referencias 
a Snaps, o desactivar las casillas de verificación para deshabitarlas. 

 
o SE: Se ajusta al punto final de un elemento. 
o SM: Se ajusta al punto medio de un elemento. Al colocar un elemento en la 

pared (como una ventana, puerta o abertura), puede usar el Snap del punto 
medio, SM, para ajustar la colocación al punto medio del segmento de pared. 

o SN: Identifica al elemento más cercano. Si desactiva esta opción el software 
permite forzados de cursor de “salto” (jump snaps) a puntos finales, puntos 
medios y centros. Un forzado de cursor de salto es un punto de forzado a 
más de 2 mm del cursor en pantalla. 

o SW: Identifica las rejillas de los planos de trabajo. 
o SQ: Identifica un punto cuadrante de un arco, círculo, elipse o arco elíptico. 
o SI: Identifica las intersecciones. 
o SC: Identifica el centro de un arco. 
o SP: Identifica elementos perpendiculares. 
o ST: Identifica tangente de un arco. 
o SX: Identifica los puntos del emplazamiento. (Survey point / Project base 

point) 
o SR: Permite forzados de cursor de salto (jumps snaps) a objetos que no 

están cerca del elemento. 
o PC: Identifica puntos o superficies en una nube de puntos. 

 
Configuración de Dimensiones Temporales 
 
Conforme crea o selecciona una geometría, Revit añade cotas temporales al elemento. 
Utilice las cotas temporales para controlar de forma dinámica la colocación de los elementos 
en el modelo. 
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Una vez colocado el elemento, Revit muestra las cotas temporales. Si se coloca otro 
elemento, las cotas temporales del elemento anterior desaparecen. Cuando se seleccionan 
varios elementos en Revit, no se muestran las cotas temporales ni las restricciones. Puede 
utilizar la opción Activar cotas para visualizarlas. 
 

1. Seleccionar varios elementos en el área de dibujo. 
2. En la barra de opciones, hacer click en Activate Dimensions. 
 

 
 
Puede cambiar el tamaño del texto y el fondo que se utiliza para mostrar las cotas 
temporales: 
 

1. Hacer click en la pestaña File → Options. 
2. En el cuadro de diálogo Options, hacer click en la pestaña Graphics. 
3. En Temporary dimension text appearance especificar el tamaño de letra y el 

fondo (transparente u opaco). 
 

 
 
Nota: Si no se muestran las cotas temporales ni las restricciones, el rendimiento del 
sistema aumenta de forma considerable. 
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Ejes y Niveles 
 
Niveles 
 
Los niveles son planos horizontales infinitos que determinan la altura vertical del edificio. 
 
Al crear elementos en un piso, como paredes o columnas, se requiere un nivel inicial y final. 
Los objetos se ligan a estos planos. Por lo tanto, los cambios realizados a la localización de 
un plano propagan automáticamente a los objetos ligados. Por ejemplo, un muro podría 
empezar en el primer nivel y terminar en el nivel de la azotea. Si cualquiera de los dos 
niveles cambia, el muro se actualizará automáticamente en todas las vistas del proyecto. 
 
Para añadir niveles, es preciso estar en una vista de alzado o sección. 
 

 
 
Similar a la creación de los Ejes, la creación de niveles en Revit es algo básico que debe 
hacerse al principio del proceso de modelado. Cuando los niveles se definen desde el 
principio, el modelador puede aprovechar las opciones que ofrece Revit, como los 
elementos de conexión a los niveles (de piso) o copiando un cierto diseño de un nivel a otro. 
 
Para crear niveles: 
 

1. Activar cualquier vista de elevación o corte. 

2. En la Pestaña Structure → Panel Datum → Level   
3. En la Pestaña Modify → Panel Draw escoger la opción requerida para dibujar el 

nivel. 
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Elegir la opción “Line”  para dibujar el nivel como una línea definiendo un punto inicial y 
punto final. 

• Elegir la opción “Pick Line”  para colocar un nivel con respecto al elemento 
que usará como referencia. 

 

4. Definir si crear un vista del nivel activando  de ser así, que tipo de vista 

en . 

5. Establecer un “Offset” (Desfase)  con respecto al punto (con 
opción line) o el elemento (con opción Pick Line) de colocación, en la barra de 
opciones. 

 

 
 
Nota: Al crear un nivel con la herramienta Pick Line y con el desfase definido podemos 
visualizar una línea de proyección donde se colocará, con respecto al elemento identificado 
por el cursor. 
 
Consideraciones: 
 

• Los niveles deben basarse en convenciones de nomenclatura claras. Esto dejará en 
claro a todos los usuarios lo que denota el nivel. 

• Mantener los mismos niveles, tanto en altura como en nombre, en varios archivos 
de proyecto, reduce los problemas de coordinación que surgen debido a los niveles 
variables. 
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Ejes 
 
Mientras que los niveles se utilizan para dividir el modelo horizontalmente (pisos), las 
cuadrículas proporcionan una referencia vertical continua a través de un edificio y 
generalmente coincidirían con la cuadrícula de columnas tradicional. Las cuadrículas 
dividen el modelo en coordenadas X y Y. Las rejillas determinan el ritmo general del edificio. 
Las cuadrículas más comunes son de naturaleza rectangular, sin embargo, también existen 
cuadrículas más complejas. Independientemente de la complejidad, el objetivo es tener un 
marco de referencia que se pueda utilizar durante la fase de diseño y construcción. Durante 
la fase de modelado, la colocación semiautomática de columnas se puede hacer en función 
de la cuadrícula. Además, se puede colocar un muro y adjuntarlo a las líneas de la 
cuadrícula. Si se ajusta la cuadrícula, también se ajusta todo lo que se adjunta a la 
cuadrícula. 
 

 
 
Para crear Ejes: 
 

1. Activar una vista en planta. 

2. Escoger Pestaña Structure → Panel Datum → Grid  
3. Definir punto inicial y final del eje. 

 
Podemos crear los ejes con las herramientas de dibujo de líneas y “Pick Line” mencionados 
anteriormente. 
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Ejes Multisegmento 
 
Los ejes multisegmento permiten crear más de un segmento de línea haciendo flexible 
la dirección y forma del eje. 
 
Para crear ejes multisegmento: 
 

1. Escoger en la Pestaña Structure → Panel Datum → Grid  

2. Se activa la herramienta Multi-Segmento  en la Pestaña Modify → Panel 
Draw. 

3. Dibujar el recorrido del eje. 
 

 

4. Presionar el botón (Finish Edit Mode). 
 

 
 
Consideraciones: 
 

• La orientación hacia el Norte del Proyecto. 

• Las cuadrículas se pueden usar para la creación de elementos como las columnas. 
 
Recomendación: 
 
Si un proyecto consta de varios edificios, configure una cuadrícula para cada uno 
independientemente del otro. 
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Capítulo 2 
 

Creación de familias 
 
Introducción a las familias 
 
Para comenzar con el Editor de Familias, es importante comprender algunos conceptos 
básicos y terminología. Todos los elementos en la plataforma de Revit son parte de una 
familia y encajan en una jerarquía claramente definida. En el nivel superior de esta jerarquía, 
se encuentran las Categorías. Las categorías están predefinidas dentro del software y no 
se pueden agregar, eliminar o renombrar. Se incluye una amplia variedad de categorías en 
Revit y se distribuyen entre unos pocos grupos maestros generales que incluyen: modelo y 
anotación (pero hay algunos otros). Las categorías de modelos incluyen todos los 
elementos que componen su modelo de construcción, tales como: paredes, puertas, pisos, 
escaleras y vigas. Las categorías de anotación incluyen elementos como Texto, 
Dimensiones y Etiquetas. 
 
Las categorías son, por definición, muy amplias. No sería suficiente tener simplemente una 
categoría de Muros o Puertas. Estos artículos vienen en todas las formas, tamaños y 
comportamientos. Por lo tanto, el siguiente nivel de la jerarquía es la Familia. Revit incluye 
muchas familias como la familia de muro "Basic Wall" entre otras, y muchas familias de 
anotaciones como "Text" o "Linear Dimension Style". Incluso las vistas en sí mismas, como 
vistas de planta y secciones, son familias de sistemas en Revit. Las familias se dividen en 
dos tipos principales: la familia del sistema (System Family) y la familia de componentes 
(Loadable / Cargables). Además de las familias de sistema y cargables tenemos u tercer 
tipo de familia llamada familia en sitio (In-Place Family). 
 
Las familias pueden tener más de un: Tipo. Un tipo es nuestra siguiente jerarquía en Revit. 
En ellos encontramos tamaños, materiales u otras configuraciones. Una familia puede 
contener uno o más tipos; cada uno con su propia configuración única editable por el 
usuario. Entonces, si bien, por ejemplo, no podemos crear o eliminar familias de muros, 
podemos agregar, eliminar y editar los tipos asociados con cada una de las familias de 
sistema. 
 
Procedimiento recomendado para la creación de familias 
 

1. Crear un archivo de familia a partir de la plantilla adecuada.  
La elección de la plantilla es importante ya que contienen configuraciones básicas, 
comportamientos y en muchos casos, geometría simple o planos de referencia. 

 
2. Agregar planos de referencia, parámetros y geometría.  

Los planos de referencia proporcionan la base para la familia, Algunas plantillas ya 
los contienen y se usan o modifican. Una vez creados o adecuados opcionalmente 
se restringen o se asignan parámetros a ellos, y luego se crea la geometría 
bloqueándola a los planos de referencia. De esta manera, los planos de referencia 
realmente controlan la geometría. 
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Tipos de geometría de forma sólida y vacía 
 
La geometría en las familias consiste en formas sólidas y vacías. Las formas sólidas 
representan las partes físicas reales de la familia y las formas vacías se utilizan para cortar 
porciones de las formas sólidas. Ambas formas sólidas y vacías vienen en cinco variedades. 
Estos incluyen: Extrusion, Blend, Revolve, Sweep y Swept Blend. 
 

 
• Extrusion: Es una forma de un boceto empujada a lo largo de una distancia 

perpendicular al plano donde se dibujó el boceto.  

• Blend: Es similar a la extrusión, exceptuando que la forma superior e inferior puede 
variar. Revolve: Gira una forma de boceto alrededor de un eje.  

• Sweep: Empuja una forma de boceto o perfil cargado a lo largo de una ruta 
especificada.  

• Swept Mezcla las propiedades de blend y sweep. A diferencia de sweep solo 
contiene un segmento de línea.  

 
Familias anidadas 
 
Manejar una forma compleja puede volverse complicado. En muchos casos, tiene sentido 
dividir las familias por piezas e insertar estas piezas en una familia que represente el todo 
del objeto. A esto se le conoce como familias anidadas. Administrar familias complejas de 
esta manera otorga más control y flexibilidad. 
 
Subcategorías y Parámetros de visibilidad. 
 
Cada uno de los elementos dentro de una familia puede pertenecer a una subcategoría. 
Las subcategorías proporcionan un nivel adicional de visibilidad y control gráfico sobre las 
partes de una familia.  
Los parámetros de visibilidad son otra forma de controlar elementos dentro de una familia. 
Estos parámetros otorgan al usuario la posibilidad de activar y desactivar la visibilidad de 
un elemento dependiendo si es necesario mostrarlo o no según una situación dada. 
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Capítulo 3 
 

Columnas de Acero 
 
Las columnas estructurales se utilizan para modelar elementos portantes verticales en una 
construcción. Aunque las columnas estructurales comparten muchas de las propiedades de las 
columnas arquitectónicas, tienen propiedades adicionales definidas por su configuración y las 
normas del sector.  
 
Unas de las características estructurales más relevantes para diferenciar una columna 
arquitectónica de una estructural es que, las estructurales cuentan con un modelo analítico 
que se utiliza para el análisis estructural y al trabajar con otros componentes estructurales 
(vigas, arriostramientos o cimentaciones), estos se unen a las columnas estructurales. 
 
 
Cargar columnas estructurales 

1. Escoger pestaña Structure => Panel Component  => Load Family . 
2. En biblioteca de familias buscar categoría Structural Columns. 

 

 
 

3. Seleccionar la carpeta Steel=> Seleccionar la familia deseada. 
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Colocación de columnas estructurales 
 
Para la colocación de columnas estructurales se recomienda trabajar con una vista 
Structural Plan ya que cuentan con algunas configuraciones por defecto que ayudan con la 
representación y visualización de las familias. 

1. Escoger pestaña Structure=> Panel Structure=> Column  
 
 
Al iniciar el comando se activará un panel en la pestaña llamada Place Structural Column, 
en este se encontrará la opción para cargar una nueva familia de columna estructural, los 
métodos de colocación de columnas y la opción para colocaciones múltiples. 
 

 
 
En la barra de Placement el programa permitirá escoger entre dos métodos de colocación 
para columnas: Columnas Verticales o Columnas Inclinadas. 
 
 
Vertical Columns (Columna Vertical) 
 

1. Iniciar comando de Columns. 
2. Escoger pestaña Modify=> Panel Placement=> Vertical Column. 
3. En la barra de propiedades seleccionar el pilar que se desea usar. 
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4. Se desplegará una Barra de opciones para poder editar propiedades de columnas 
antes de añadirlo al modelo. 

 

 

• Rotate after placement. Seleccione esta opción para rotar el pilar inmediatamente 
después de colocarlo. 

• Level. (Solo vistas 3D). Seleccione un nivel para la base del pilar. Para las vistas de 
plano, el nivel de vista es el nivel base del pilar. 

• Depth. Este parámetro dibuja el pilar hacia abajo a partir de su base. Para dibujar el 
pilar hacia arriba desde su base, seleccione Height. 

• Level/Unconnected. Seleccione un nivel para la parte superior de del pilar, o 
seleccione No conectada y especifique la altura del pilar. 

5. Colocar la columna en la vista deseada. 
Las columnas se ajustan mediante forzado de cursor a la geometría existente. Al 
colocar las columnas en las intersecciones de los ejes, se resaltan ambos conjuntos 
de líneas de ejes. 
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IMPORTANTE: Mientras se colocan los pilares se puede utilizar la barra espaciadora para 
cambiar la orientación de la columna. Cada vez que se pulse la barra espaciadora, el 
componente rotara para alinearse con ejes y en caso de no haber ejes, la columna se rotara 
90 grados 
 
 

 
 
Colocación múltiple 
 
Esta herramienta nos permite colocar varias columnas estructurales en la intersección 
líneas de ejes seleccionadas. La herramienta se habilita al activarla en una vista en planta. 
 
Para realizar una colocación múltiple de columnas estructurales: 
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1. Iniciar comando de Columns. 
2. En la Barra de Properties seleccionar la columna que se desea usar. 

 

 
 

3. Escoger pestaña Modify=> Panel Multiple=> At grids . 
4. Seleccionar los ejes que se deseen para definir las intersecciones. 
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El comando generara una previsualización de las columnas en la posición donde se 
van a colocar. 
 

5. Se puede usar la barra espaciadora para rotar todas las columnas a una orientación 
deseada. 

6. Hacer click en Finish para terminar comando y colocar las 
columnas. 
 

 
Slanted Columns (Columna Inclinada) 
 
Para la colocación de columnas inclinadas existen unas consideraciones generales un 
modelado apropiado: 
 

• La herramienta Copy/Monitor no funciona para columnas inclinadas. 

• Cuando se coloque la columna inclinada, el punto final de la elevación superior será 
la parte superior (Top) y la elevación inferior será la base (Bottom). 

• Una vez determinado el nivel para ambos puntos (Top y Bottom) no se pueden 
invertir los niveles. 
 

Colocación de columnas inclinadas: 
 

1. Iniciar comando de Columns. 
2. Escoger pestaña Modify=> Panel Placement=> Slanted Column. 
3. En la barra de propiedades seleccionar el pilar que se desea usar. 
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4. Se desplegará una Barra de opciones para poder editar propiedades de columnas 
antes de añadirlo al modelo. 

 

 

• 1st Click. (Solo para la colocación de vistas de plano) Seleccione el nivel para el 
punto inicial del pilar. Especifique un desfase para el extremo del pilar en el cuadro 
de texto. 

• 2nd Click. (Solo para la colocación de vistas de plano) Seleccione el nivel para el 
punto final del pilar. Especifique un desfase para el extremo del pilar en el cuadro 
de texto. 

• 3D Snapping. Seleccione Forzado de cursor 3D si desea el forzado de cursor a 
elementos estructurales previamente colocados para uno de los extremos del pilar 
(o para ambos). Este es el método de colocación más preciso al colocar vistas en 
sección, de alzado o 3D. 

5. En una vista en planta, hacer clic en el punto inicial de la columna donde se aplicará 
el nivel especificado en 1st Click.  
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6. Realizar un segundo clic en el punto final de la columna donde se aplicará el nivel 
especificado en 2nd Click. 

 
 
 
IMPORTANTE: las columnas inclinadas también se pueden colocar en alzados o secciones. 
 

1. Iniciar el comando de Columns=> Seleccionas Slanted Column=> Seleccionar perfil 
a usar. 

2. Abrir la vista en alzado o sección en la que se desea trabajar. 
3. Se abrirá una ventana nueva donde se tiene que especificar el plano de trabajo 

(Work Plane) donde se desea colocar la columna. 
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4. Una vez especificado el plano de trabajo (Work Plane) se colocará punto inicial 
donde se desea colocar la columna. 

 
5. Se realizará un segundo clic para definir el punto final de la columna inclinada=> 

Finalizar comando. 

 
 
IMPORTANTE: al crear las columnas inclinadas por medio de alzados o secciones, los 
niveles asociados al primer y segundo clic se ligarán al nivel más próximo. 
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Modificación de columnas inclinadas 
 
Las columnas inclinadas tienen parámetros únicos que afectan el modo en que estos 
interactúan con otros componentes estructurales 
 
Column Style para columnas inclinadas 
 
Las columnas estructurales cuentan con un parámetro que nos ayuda a definir el ajuste 
paramétrico de las mismas con respecto a otros componentes dentro del modelo. Este 
parámetro se encuentra en la barra bajo el nombre de Column Style. 
 
Este parámetro cuenta con tres valores de ajuste:  
 

• Vertical. 

• Slanted – Angle Driven. 

• Slanted – End Point Driven. 
 

 
 

1. Slanted – Angle Driven 
 

Este estilo permite controlar la inclinación de la columna por medio de un ángulo fijo, 
manteniendo el mismo cuando se cambia la posición de los componentes enlazados a la 
columna.  
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2. Slanted – End Point Driven 

 
Este estilo permite mantener la posición de los extremos unidos cuando se cambia la 
posición de los componentes enlazados. 
 

 
Justificación de enlace de extremo de pilar y estilos de corte 
 
Puede definir el aspecto de un extremo de columna al enlazarse a algún componente 
estructural (losas, vigas, etc). La geometría de extremo de la columna se desfasa o se corta 
según las opciones de Justificación de enlace seleccionadas. 
 
Estas opciones de justificación las podemos encontrar en la paleta de propiedades bajo el 
grupo Construction, se podrá editar el tipo de justificación de en la base o en la parte 
superior.  
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En caso de que las columnas inclinadas no estén enlazadas a ningún componente 
estructural, se puede cortar o ajustar la geometría de la columna por medio de la 
herramienta Cut Style, la cual se encuentra en la paleta de propiedades bajo el grupo de 
Construction. 

 
 
Modificar la inclinación de una columna 
 
La inclinación de las columnas verticales o las columnas inclinadas existentes se puede 
modificar por medio de controladores o restricciones en una vista 3D. 
 
Dentro de una vista 3D donde se vaya a modificar la columna 
 

1. Seleccionar la columna a modificar. 
2. Desde la paleta de propiedades modificar el parámetro Column Style a algún estilo 

de columna inclinada=> Aplicar  
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Al seleccionar un Column Style determinado para columna inclinada se integran 
controladores a la geometría para modificar la inclinación. 
 

1. Slanted – Angle Driven 
 
Esta opción permite controlar la inclinación de la columna, manteniendo la altura 
constante. 

 
 

2. Slanted – End Point Driven. 
 
Esta opción permite controlar la inclinación y la altura de la columna por medio de 
controladores de flecha. 

 



64 
 

Herramientas de ajuste manual 
 
Las columnas inclinadas incorporan controladores de arrastre y cambio de tamaño para 
modificaciones manuales. 

 
1. Controladores de Flecha vertical (Shape Handle). 

 
Los controladores de flecha aparecen en los extremos (Top y Bottom) de la columna 
inclinada. Al arrastrarlos permiten modificar la elevación de ambos extremos.  
 

 
 
Estos controladores cuando la columna tiene el Column Style de Slanted – End Point 
Driven y pueden desaparecer cuando el pilar esta enlazado a un componente 
estructural (vigas y losas) y a un plano de referencia. 
 

2. Controladores de punto (Column Handle) 
 
Los controladores de punto nos ayudan a ajustar la posición de los extremos Top y 
Bottom de la columna. 
 

 
 

3. Controladores de texto. 
 
Los controladores de texto ajustan de forma directa el parámetro de desfase. Nos 
permite ingresar un valor manualmente. 
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Los controladores de texto se desactivan cuando la columna se enlaza a algún 
componente estructural (vigas y losas) y a un plano de referencia. 
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Creación de una familia de Columna Estructural 
 
Selección de plantilla 

1. Desplegar File Tab  (Ficha de Archivo) => opción New => opción Family. 
2. Escoger la plantilla adecuada para columna estructural. => Open 

 
 

Esta plantilla cuenta con parámetros específicos que ayudan a construir la familia 
de columna estructural. 

 
Configuraciones iniciales y parámetros predeterminados 
 

Definir tipo de sección y material por medio de la paleta de propiedades. 
Esto proporcionan cotas adicionales y propiedades estructurales con las que puede 
implementar aplicaciones de análisis externas. 

 
1. Para definir tipo de sección (Section Shape): 

 
2. Paleta de propiedades=> Grupo Structural=> Seleccionar parámetro Section Shape 

 
 

 
 

3. En la ventana de Section Shape seleccionar el tipo de sección con el que se desee 
trabajar para adquirir propiedades preestablecidas=> Ok 
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Para definir material para el comportamiento en modelo (Material for model Behavior): 
 

1. Paleta de propiedades=> Grupo Structural=> Seleccionar parámetro Material for 
model Behavior=> Seleccionar Steel. 

 
 
Cuando se selecciona un section shape se generan propiedades predeterminadas para 
construir la forma que se desea generar. Estos parámetros se modifican según el section 
shape que se selecciono 
 
Para visualizar los parámetros predeterminados: 

1. Escoger pestaña Create => Panel Properties => Family Types . 
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Esta pestaña nos permitirá ver los parámetros predeterminados por el section shape 
y los parámetros creados por el usuario. 

2. Los parámetros predeterminados se crean en tres grupos para poder colocarle 
información a la familia: 

• Dimensions: estos parámetros contienen información para especificar 
dimensiones de pernos, colocación, etc. 

• Structural Section Geometry: estos parámetros nos ayudan a la construcción 
del perfil para la familia. 

• Structural Analysis: estos parámetros contienen información analítica de las 
secciones, esta información puede ser consultada directamente en el 
catálogo del proveedor.  
 

 
 

Ejemplo de los parámetros Structural Section Geometry para shape I-Shape Wide Flange. 
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• B: Ancho externo de la sección. 

• H: Alto externo de la sección. 

• T: Espesor de ala de sección. 

• t: Espesor de alma de sección. 

• r: Radio de empalme. 

• y: Centroide horizontal de sección. 

• z: Centroide vertical de sección.  
 
IMPORTANTE: Se recomienda utilizar los parámetros predeterminados para generar la 
familia ya que estos parámetros están ligados a la creación de Conexiones Estructurales 
de sistema. 
 
Definición de planos de referencia, creación de cotas y asignación de parámetros 
 
La herramienta Reference Plane crea un plano de referencia, que es un plano infinito que 
sirve como guía para dibujar líneas y geometría. 
 
Para crear planos de referencia: 
 

1. Escoger pestaña Home => Panel Datum => icono . 
2. Dibujar la línea para el plano de referencia en la ubicación requerida, definiendo un 

punto inicial y un punto final. 
 

 
 
Una vez creados los planos de referencia es necesario acotar los planos para poder 
restringir distancias y tamaños que vayan a afectar la geometría 
 
Para colocar cotas: 
 

1. Escoger la pestaña Annotate=> Panel Dimension=> escoger la opción de cota 
requerida. 
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Será necesario colocar cuantas cotas se requieran para tener control total sobre el 
comportamiento del elemento. 
 
Las cotas igualitarias permiten controlar que un objeto al modificar el tamaño lo haga 
en forma proporcional hacia los dos lados de los planos de referencia principales. 
 

Al tener las cotas creadas se les puede asignar los parámetros predeterminados que se 
crearon al asignar un section shape. 
 
Para crear y asignar parámetros de tipo: 
 

1. Seleccionar la cota(s) a la cual se le asignará el parámetro. 
2. En la barra de herramientas de opciones desplegar la casilla Label: y escoger el 

parámetro predeterminado. 
 

 



71 
 

3. Asignar los parámetros a las cotas generadas 
 

 
 

IMPORTANTE: Para las cotas que restringen la forma y construcción de la geometría es 
necesario usar los que están en el grupo Structural Section Geometry. 
 
Definición de geometría y restricciones. 
 
Para la creación de la geometría se utilizará la herramienta Extrusion desde la vista en 
planta donde se definieron los planos de referencia y cotas con parámetros: 
 

1. Desde la pestaña Create=> Panel Forms=> Extrusion  . 
2. Crear el perfil de la forma. 
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Mientras se estén creando los perfiles de las formas, asegurarse que los segmentos 
de líneas coincidan con los planos de referencia, para que estos queden vinculados, 
además debe bloquear el vínculo. 
 

 

3. Finalizar figura con comando Finish Edit Mode . 
4. Una vez finalizada la forma abrir una vista lateral o frontal de la familia. 



73 
 

 
En esta vista se podrán visualizar dos niveles que representan el nivel inferior y el 
nivel superior que tendrá la columna. 
 

5. Seleccionar la extrusión y editar la altura del volumen mediante los controladores de 
flecha. 
 

 
 

6. De igual manera a como se restringió el perfil de la extrusión a los planos de 
referencia, es necesario restringir la altura del perfil a los niveles Upper y Lower de 
la plantilla 
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Asignar material 
 
Al crear el volumen, este cuenta con un material por defecto, este se puede modificar desde 
el editor de familias o mediante un parámetro para posteriormente modificarlo desde un 
proyecto. 
 
Para asignar un material desde el editor de familias: 
 

1. Seleccionar extrusión=> Desde la paleta de propiedades=> Grupo Material and 
Finishes=> Material. 
 

 
2. Crear un material para asignarlo a volumen=> Asignarle nombre 
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3. Asignar características a material. 
 
Abrir Asset Browser=> Abrir la librería Apparence Library=> Abrir carpeta Metal=> 
Seleccionar apartado Steel 
 

 
 

Seleccionar material=>Utilizar botón Replace the current asset para sobrescribir la 
apariencia al material nuevo. 
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4. Seleccionar Material=> Ok 
 
Para asignar un material por parámetro: 
 
La plantilla de Structural Column tiene un parámetro de material por defecto que están en 
el menú de Family Type. Aquí se puede asignar un material a la familia como el 
procedimiento anterior. 
 

 
 

Para que este parámetro afecte la geometría creada en la familia: 
 

1. Seleccionar extrusión=> Desde la paleta de propiedades=> Grupo Material and 
Finishes=> Material=> Seleccionar botón Associate Family Parameter. 
 

 
 

 
2. Seleccionar parámetro Structural Material. 
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Esto asociara el parámetro de material de la geometría con el de la plantilla de 
Structural Column.  
 

3. Asignar un material desde Family Type como el procedimiento anterior 
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Capítulo 4 
 

Vigas de Acero 
 
Las vigas estructurales se utilizan para modelar elementos portantes horizontales en una 
construcción.  
 
Cargar vigas estructurales 

1. Escoger pestaña Structure => Panel Component  => Load Family . 
2. En biblioteca de familias buscar categoría Structural Framing. 

 

 
 

3. Seleccionar la carpeta Steel => Seleccionar la familia deseada. 
 

 



79 
 

Colocación de vigas estructurales 
 
Para la colocación de vigas estructurales se recomienda trabajar con una vista Structural 
Plan ya que estas cuentan con algunas configuraciones por defecto que ayudan con la 
representación y visualización de las familias. 

1. Escoger pestaña Structure=> Panel Structure=> Beam  
 
Al iniciar el comando se activará un panel en la pestaña llamada Place Beam en este se 
encontrará la opción para cargar una nueva familia de viga estructural, los métodos de 
colocación de columnas y la opción para colocaciones múltiples. 
 

 
 
En la barra de Draw el programa nos permite escoger un método de boceto para dibujar las 
vigas entre los que podemos encontrar:  

• Línea recta. 

• Arco de inicio-fin-radio. 

• Arco de centro-punto final. 

• Arco tangente de punto final. 

• Arco de empalme. 

• Spline. 

• Elipse parcial. 
 

Vigas rectas y colocación en cadena 
 
Para la colocación de vigas rectas: 
 

1. Iniciar comando de Beam. 
2. Escoger pestaña Modify=> Panel Draw=> seleccionar la opción Line. 

 

 
 

3. En la barra de propiedades seleccionar la viga que se desea usar. 
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4. Se desplegará una barra de opciones para poder editar propiedades de viga antes 
de añadirlo al modelo. 
 

 

• Placement Plane. Nos ayuda a definir un nivel, plano de colocación o un plano de 
trabajo distinto al nivel actual. 

• Structural Usage. Se puede asignar un uso estructural de manera manual o escoger 
la opción de asignar el uso de manera automática 

• 3D Snapping.  forzar el cursor a otros elementos estructurales de cualquier vista. 
Puede dibujar bocetos de vigas fuera del plano de trabajo actual. Por ejemplo, 
cuando se activa el forzado de cursor 3D, se forzará el cursor de las vigas de 
cubierta a la parte superior de los pilares, independientemente del alzado. 

• Chain. Esta herramienta permite colocar vigas de forma sucesiva. El segundo clic al 
colocar una viga determinará el inicio de la siguiente viga. Pulse Esc para finalizar 
la colocación de vigas en cadena 

5. Colocar la viga 
La creación de vigas será haciendo clic en el punto inicial de la viga seguido de un 
segundo clic en el punto final 
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Antes de dar el segundo clic del punto final, la herramienta nos permite ingresar un 
valor numérico para la longitud de la viga. El valor se puede asignar desde el teclado 
numérico. 

 
 
 

 
 
IMPORTANTE: si el modelo cuenta otros componentes estructurales (muros y columnas) 
el cursor se fuerza hacia el centroide de estos componentes. Este forzado de cursor también 
ocurre en ejes y en la intersección de ejes. 
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Para colocación en cadena: 
 

1. Iniciar comando de Beams. 
2. En la barra de opciones activar la casilla Chain. 

 

 
 

3. Dar primer clic para el punto inicial de la viga, al dar el segundo clic se activará el 
parámetro Chain que permite hacer vigas continuas. 
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Colocación múltiple 
 
Esta herramienta nos permite colocar varias vigas estructurales en líneas de ejes. La 
colocación automática necesita de otros componentes estructurales (muros, columnas y 
vigas) para realizar el comando. 
 

• Si existe un muro en la línea de eje, no se colocará una viga en el muro. 

• Los extremos de muros se definen como soportes. 

• Si una viga interseca o cruza una línea de eje, la viga se considera como un soporte 
intermedio. 

 
Para realizar una colocación múltiple de columnas estructurales: 
 
IMPORTANTE: para este ejemplo se considera un arreglo de columnas, muros y vigas que 
ayudara a realizar el comando. 
 

 
 

1. Iniciar comando de Beams. 
2. En la Barra de Properties seleccionar la viga que se desea usar. 
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3. Escoger pestaña Modify=> Panel Multiple=> On grids . 
4. Seleccionar los ejes donde se desee generar las vigas. 
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El comando generara una previsualización de las columnas en la posición donde se 
van a colocar. 

 
IMPORTANTE: el comando detecta cualquier elemento portante que este en los 
ejes, por lo tanto, si no hay componentes estructurales no generara una 
previsualización de las vigas. 

5. Dar clic en Finalizar . 
 

 
Vigas curvas 
 
Puede dibujar las vigas curvas tanto en la vista de plano como en la de alzado, ya que la 
geometría de éstas puede curvarse. 
 
Para crear una viga curva: 
 

1. Iniciar comando de Beam. 
2. Escoger pestaña Modify=> Panel Draw=> seleccionar alguna de las opciones de 

línea curva: 
 

 
 

• Arco de inicio-fin-radio 

• Arco de centro-punto final 

• Arco tangente de punto final 

• Arco de empalme 

• Spline 

• Elipse parcial 
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3. Colocar los puntos (inicial y final) en el área de dibujo para completar la sección de 
línea curva. 

 
Vigas inclinadas 
 
Si se trabaja un proyecto que contiene elementos inclinados complejos (viertas, losas, etc) 
para los que se necesitan añadir losas, se puede seguir el siguiente procedimiento para 
modelar vigas inclinadas. 
 

1. Seleccionar la viga que se desee editar. 

 
 

2. Paleta de propiedades=> Grupo Constraints=> Existen dos parámetros para 
ingresar un desfase en el punto inicial o el punto final de la biga. 
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Estos parámetros tienen un valor de cero por defecto al crear la viga 
 

3. Escribir un valor numérico en parámetro que se desee afectar=> Apply 
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Uso estructural de vigas 
 
Revit Structure permite asignar un uso estructural a las vigas de manera automática 
basándose en los elementos estructurales relacionados con la viga. Este valor determina el 
estilo de línea que tiene la línea al representarlo en un nivel de detalle Coarse. 
 
Para asignar un uso estructural en la viga: 
 
Se puede asignar un valor al parámetro Structural Usage antes o después de colocar la 
viga. 
 
 Antes de colocar una viga 
 

1. Iniciar el comando Beam. 
2. Desde la paleta de propiedades=> Structural=> Structural Usage. 

 

 
 

Desde la barra de opciones=> Structural Usage 
 

 
 

3. Seleccionar el uso estructural que se desee aplicar.  
 

Después de colocar una viga 
 

1. Seleccionar la viga que se desee editar. 
2. Desde la paleta de propiedades=> Structural=> Structural Usage. 
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3. Seleccionar el uso estructural que se desee aplicar.  
 
La herramienta contempla cinco usos estructurales para vigas: 
 

Girder Viga Principal 

Joist Viga Secundaria 

Purlin Largueros 

Horizontal Bracing Contraventeo Horizontal 

Other Uso definido por el usuario 

 
Para la colocación automática, el programa define el uso estructural basado en los 
elementos que conecta la viga. 
 

 Columna Contraventeo Contraventeo 
Horizontal 

Girder Joist Purlin Other 

Muro G O HB G J P O 

Columna G O HB G J P O 

Contraventeo  O O O O O O 

Contraventeo 
Horizontal 

  HB HB HB HB O 

Girder    J J P O 

Joist     P P O 

Purlin      P O 

Other       O 
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Modificación de vigas estructurales 
 
Herramientas de ajuste manual 
 
Al igual que las columnas inclinadas, las vigas incorporan dos tipos de controladores para 
poder editar el componente 
 

• Beam Handles 
 
Son controladores con forma de círculos azules que indican donde se coloca el 
extremo de la viga 
 

 
 

Estos controladores tienen una restricción vertical al nivel o plano de referencia en 
el que fueron creados, por lo que solo se pueden mover de manera horizontal. 

 

 
 

• Shape Handles 
 

Los controladores de flecha aparecen en los extremos de la viga y nos ayudan a 
ajustar manualmente la geometría de las vigas. 
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IMPORTANTE: ambas herramientas de ajuste manual tienen un ajuste forzado a otros 
componentes estructurales (vigas, columnas y muros) así como a líneas de ejes. 
 
Ajuste de elevación de viga 
 
La elevación de la viga estructural se puede modificar de manera paramétrica por medio de 
la conexión a otros componentes estructurales. 
 
Las vigas tienen un parámetro en la paleta de propiedades el cual ayuda a orientar los 
extremos de la viga, estos son Start Attachmen Type y End Attachment Type. 
 

 
 
Este parámetro da la oportunidad de escoger entre dos opciones: End Elevation (por 
defecto) y Distance. 
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• End Elevation. 
 
El End Elevation orienta los extremos de la viga hacia la elevación en que se ha 
modelado la viga 

 
 

• Distance. 
Distance orienta los extremos de la viga a la ubicación de la unión de pilar 
 

 
 

Justificar geometría de viga estructural 
 

• Línea de ubicación de viga 
 

La línea de ubicación es una herramienta de referencia que nos ayuda a modificar las 
vigas estructurales. Esta línea se puede visualizar en todas las vistas en todo momento. 
 
Para visualizar la Línea de ubicación: 
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1. Desde la vista donde se desee trabajar abrir Visibility/Graphics. 
2. En cuadro de dialogo buscar categoría Structural Framing=> Desplegar 

menú=> Activar Location Lines. 
 

 
 

IMPORTANTE: La línea de ubicación está representada por una línea azul. 
 
Las vigas cuentan con parámetros que reubican la geometría en relación con la línea de 
ubicación. Estos parámetros se encuentran en la paleta de propiedades al seleccionar la 
viga, bajo el grupo de Geometric Position. 
 

 
 
 
 

• Justificacion en Y 
 
Este parámetro da la posibilidad de modificar la posición de la geometría en el eje 
Y, dando cuatro posibilidades de posición: Origin, Left, Center y Right. 
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IMPORTANTE: la distancia que tiene de desfase con respecto a la línea de ubicación va a 
ser 0.00 por defecto, este valor se puede modificar a cualquier valor numérico con el 
parámetro de y Offset Value. 
 

• Justificacion en Z 
 
Este parámetro da la posibilidad de modificar la posición de la geometría en el eje 
Z, dando cuatro posibilidades de posición: Origin, Top, Center y Buttom. 
 

 
 
IMPORTANTE: la distancia que tiene de desfase con respecto a la línea de ubicación va a 
ser 0.00 por defect, este valor se puede modificar a cualquier valor numérico con el 
parámetro de Z Offset Value. 
 
Reducción en uniones de extremos 
 
Cuando exista una unión final entre dos vigas estructurales es posible generar un detalle 
de reducción o bisel entre ambas, esto mediante la herramienta Beam/Column Joins. 
 
Para generar detalle de reducción o biselado: 
 

1. En pestaña Modify=> Panel Geometry=> Beam/Colum Joins . 
 

Al activar el comando en la pantalla se resaltarán los elementos donde se pueda realizar 
el ajuste y se añade una simbología de dirección a las vigas. 
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2. Filtrar la visibilidad de controles. 
Cuando se active el comando aparecerá una barra de opciones donde te permitirá 
filtrar las simbologías que se visualizan según el tipo de viga. 
 

 
 

3. Ajustar la unión de las vigas. 
Hacer clic en las flechas para generar un ajuste en las vigas.  
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Creación de una familia de Viga Estructural 
 
Selección de plantilla 

3. Desplegar File Tab  (Ficha de Archivo) => opción New => opción Family. 
4. Escoger la plantilla adecuada para viga estructural. => Open 

 
 

Esta plantilla cuenta con parámetros específicos que ayudan a construir la familia 
de viga estructural. 

 
Configuraciones iniciales y parámetros predeterminados 
 

Definir tipo de sección y material por medio de la paleta de propiedades. 
Esto proporcionan cotas adicionales y propiedades estructurales con las que puede 
implementar aplicaciones de análisis externas. 

 
4. Para definir tipo de sección (Section Shape): 

 
5. Paleta de propiedades=> Grupo Structural=> Seleccionar parámetro Section Shape 

 

 
 

6. En la ventana de Section Shape seleccionar el tipo de sección con el que se desee 
trabajar para adquirir propiedades preestablecidas=> Ok 
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Para definir material para el comportamiento en modelo (Material for model Behavior): 
 

2. Paleta de propiedades=> Grupo Structural=> Seleccionar parámetro Material for 
model Behavior=> Seleccionar Steel. 
 

 
 

Cuando se selecciona un section shape se generan propiedades predeterminadas para 
construir la forma que se desea generar. Estos parámetros se modifican según el section 
shape que se selecciono 
 
Para visualizar los parámetros predeterminados: 

3. Escoger pestaña Create => Panel Properties => Family Types . 



98 
 

 
 

Esta pestaña nos permitirá ver los parámetros predeterminados por el section shape 
y los parámetros creados por el usuario. 

4. Los parámetros predeterminados se crean en tres grupos para poder colocarle 
información a la familia: 
 

• Dimensions: estos parámetros contienen información para especificar 
dimensiones de pernos, colocación, etc. 

• Structural Section Geometry: estos parámetros nos ayudan a la construcción 
del perfil para la familia. 

• Structural Analysis: estos parámetros contienen información analítica de las 
secciones, esta información puede ser consultada directamente en el 
catálogo del proveedor.  
 

IMPORTANTE: En el tema Creación de una familia de Columna Estructural se puede ver 
un ejemplo donde se describen los parámetros Structural Section Geometry que se crean 
al seleccionar un Section Shape. 
 
Definición de planos de referencia, creación de cotas y asignación de parámetros 
 
La herramienta Reference Plane crea un plano de referencia, que es un plano infinito que 
sirve como guía para dibujar líneas y geometría. 
 
La plantilla Structural Framing cuenta con planos de referencia que nos ayudan a la creación 
de la geometría: 
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Para crear planos de referencia: 
 

1. Escoger pestaña Home => Panel Datum => icono . 
2. Dibujar la línea para el plano de referencia en la ubicación requerida, definiendo un 

punto inicial y un punto final. 

 
Una vez creados los planos de referencia es necesario acotar los planos para poder 
restringir distancias y tamaños que vayan a afectar la geometría 
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Para colocar cotas: 
 

1. Escoger la pestaña Annotate=> Panel Dimension=> escoger la opción de cota 
requerida. 

 
Será necesario colocar cuantas cotas se requieran para tener control total sobre el 
comportamiento del elemento. 
 
Las cotas igualitarias permiten controlar que un objeto al modificar el tamaño lo haga 
en forma proporcional hacia los dos lados de los planos de referencia principales. 
 

Al tener las cotas creadas se les puede asignar los parámetros predeterminados que se 
crearon al asignar un section shape. 
 
Para crear y asignar parámetros de tipo: 
 

1. Seleccionar la cota(s) a la cual se le asignará el parámetro. 
2. En la barra de herramientas de opciones desplegar la casilla Label: y escoger el 

parámetro predeterminado. 
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3. Asignar los parámetros a las cotas generadas. 

 

 
 

IMPORTANTE: Para las cotas que restringen la forma y construcción de la geometría es 
necesario usar los que están en el grupo Structural Section Geometry. 
 
Definición de geometría y restricciones. 
 
Para la creación de la geometría se utilizará la herramienta Sweep desde la vista en planta 
donde se definieron los planos de referencia y cotas con parámetros: 

1. Desde la pestaña Create=> Panel Forms=> Extrusion  . 
2. En la pestaña Sweep seleccionar la opción Sketch Path. 
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3. En el menú de Sketch Path seleccionar la opción de Line y dibujar en vista deseada. 
 

 
 
IMPORTANTE: se deben anclar los puntos inicial y final y del sketch path a los planos de 
referencia para geometría. 
 

 
 
 

4. Salir de la edición de Sketch Path. 
 

5. Para crear el volumen del sweep, usaremos la herramienta Load Profile para poder 
cargar un perfil 2D desde la biblioteca de familias. 

 
Desde la pestaña Sweep=> Load Profile. 
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Carpeta Profiles=> Carpeta Framing=> Steel. 

 
 

Seleccionar un Perfil=> Ok 
 

 
 

6. Finalizar comando de Sweep. 
7. Abrir los parámetros de perfil. 

Project Browser=> Families=> Profiles=> Seleccionar el perfil usado en Sweep=> 
Doble clic. 
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8. Asociar los parámetros del perfil a parámetros de Structural Shape Geometry.  
 

 
 
 

Esto generara que las dimensiones del perfil se ajusten a las medidas que se 
trabajan en Structural Shape Geometry. 

 
Asignar material 
 
Al crear el volumen, este cuenta con un material por defecto, este se puede modificar desde 
el editor de familias o mediante un parámetro para posteriormente modificarlo desde un 
proyecto. 
 
Para asignar un material desde el editor de familias: 
 

1. Seleccionar extrusión=> Desde la paleta de propiedades=> Grupo Material and 
Finishes=> Material 
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2. Crear un material para asignarlo a volumen=> Asignarle nombre 
 

 
 

3. Asignar características a material. 
 
Abrir Asset Browser=> Abrir la librería Apparence Library=> Abrir carpeta Metal=> 
Seleccionar apartado Steel 
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Seleccionar material=>Utilizar botón Replace the current asset para sobrescribir la 
apariencia al material nuevo. 
 

 
 

4. Seleccionar Material=> Ok 
 

Para asignar un material por parámetro: 
 
La plantilla de Structural Column tiene un parámetro de material por defecto que están en 
el menú de Family Type. Aquí se puede asignar un material a la familia como el 
procedimiento anterior. 
 

 
 
Para que este parámetro afecte la geometría creada en la familia: 

 
1. Seleccionar extrusión=> Desde la paleta de propiedades=> Grupo Material and 

Finishes=> Material=> Seleccionar botón Associate Family Parameter.  
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2. Seleccionar parámetro Structural Material. 
 

 
 

Esto asociara el parámetro de material de la geometría con el de la plantilla de 
Structural Column.  
 

3. Asignar un material desde Family Type como el procedimiento anterior 
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Sistema de vigas 
 
Los sistemas de vigas estructurales crean un elemento de armazón estructural que contiene 
una serie de vigas individuales colocadas en paralelo. Un sistema de vigas constituye un 
método eficaz para crear un armazón alrededor de un área de una estructura que requiere 
soporte adicional. 
 
Colocación de sistema de vigas 
 
Para crear un sistema de vigas, la herramienta permite colocarla de manera automática y 
por dibujo por boceto. Los parámetros de sistema de vigas se adaptan a cambios en el 
diseño. Si cambia la ubicación de un pilar, los parámetros de sistema de vigas reflejarán el 
cambio automáticamente. 
 
Para crear un sistema de vigas automático: 
 

Se deben cumplir con las condiciones siguientes: 

• El sistema de vigas automático debe de ser creado en una vista en planta. 

• Se debe contar con elementos de soporte (muros, columnas y vigas) en un bucle 
cerrado. 

1. Escoger pestaña Structure=> Panel Structure=> Beam System  
2. Se desplegará una barra de opciones donde se debe determinar: 

 

• Beam Type – Tipo de viga que se usara en el sistema. 

• Justification – la posición que tendrá la viga con respecto a la línea de 
ubicación. 

• Layout Rule – la regla de colocación que tendrá el sistema. 
 

 
 

Estos parámetros también se encontrarán en la paleta de propiedades bajo el grupo 
Pattern. 
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3. Seleccionar la opción Automatic Beam System en el menú de Beam System.  
 

 
 

4. Seleccionar el área o tablero donde se colocará el sistema de manera automática 
 

 
 

Si el cursor se coloca sobre un componente dentro del bucle que este orientado 
horizontalmente, todas las vigas del sistema se orientaran hacia esa dirección; por 
otro lado, si el cursor se coloca sobre un elemento vertical, todo el sistema se 
orientara en esa dirección. 
 

5. Finalizar el comando 
 
Para crear un sistema de vigas por boceto: 
 
 Consideraciones: 
 

• No es necesario contar con un bucle cerrado de componentes estructurales 

• Esta opción es ideal para ajustar el sistema a elementos curvos. 
 

1. Escoger pestaña Structure=> Panel Structure=> Beam System . 
2. Seleccionar la opción Sketch Beam System en el menú de Beam System.  
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3. Los parámetros de personalización se encontrarán en la paleta de propiedades 
 

 
 
 

4. Dibujar o seleccionar las líneas que definirán el contorno del sistema de vigas 
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5. Definir la dirección de las vigas con el comando Beam Direction. 
 

 
 

6. Finalizar comando. 
 
Sistema de vigas inclinado 
 
Los sistemas de vigas pueden ajustarse a diferentes inclinaciones de componentes 
estructurales.  
 
IMPORTANTE: para que el sistema de vigas pueda adaptarse debe crearse de manera 
automática o por medio de Pick Supports en boceto ya que el programa identifica la 
pendiente que tienen estos elementos. 
 
Para crear un sistema de vigas inclinado: 
 

1. Crear un sistema de vigas de manera automática o por Pick Supports. 
 

 
 

2. En paleta de propiedades, activar el parámetro 3D en el grupo Constraints. 
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Al activar este parámetro se mostrará una nueva simbología de Slope en las líneas 
de sketch que se dibujaron. 
 

 
 

3. Finalizar comando. 
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Contraventeos  
 
Los contraventeos son miembros diagonales conectados a vigas y a pilares. Puede añadir 
tornapuntas en vistas de plano o en vistas de alzado de estructura.  
Los contraventeos se enlazan ellas mismas a vigas y pilares, y se ajustan paramétricamente 
a los cambios que se dan en el diseño de la construcción. Cuando están enlazadas a una 
viga, se puede especificar el tipo de enlace, la distancia o la proporción. También se puede 
indicar el extremo del elemento con referencia respecto al cual se establece la distancia o 
la proporción; si el extremo está enlazado a un pilar o a un muro, se puede definir el nivel y 
el desfase de la altura del punto. 
 
Colocación de contraventeos 
 
Los contraventeos se pueden copiar, mover, reflejar, organizar en matrices y rotar fuera del 
plano vertical en que se hayan creado. Estas operaciones se realizan en vistas de plano y 
3D. 
 
IMPORTANTE: Los contraventeos se pueden colocar en vitas en planta y en 
alzados/secciones. Estos contraventeos trabajan con las familias de Structural Framing. 
 
Para colocar contraventeos en vista en planta: 
 

1. Escoger pestaña Structure=> Panel Structure=> Brace . 
2. Seleccionar desde la paleta de propiedades el tipo de viga que se usara en el 

comando. 
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3. La manera de dibujar los contraventeos sera de manera lineal, definiendo un punto 
inicial y un punto final. 
 

 
 

4. Al iniciar el comando Brace, se desplegará una barra de opciones: 
 

 
 

Esta barra de opciones permite personalizar la altura de referencia que tendrá el 
punto inicial y el punto final del contraventeo. Por defecto estos valores estarán 
referenciados al nivel 1 con un desfase de cero. 

 

 
 

5. Dibujar punto inicial y punto final del contraventeo. 
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6. Finalizar comando 
 
 

 
 
IMPORTANTE: Al dibujar el contraventeo este se ligará de manera automática con los 
elementos estructurales que estén más cercanos. 
 
Para colocar contraventeos en vista en planta: 
 

1. Iniciar comando Brace. 
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2. Si se activa el comando en un alzado o sección, el programa desplegara un cuadro 
de dialogo para definir un Work Plane. 

 

 
 

3. Dibujar punto inicial y punto final del contraventeo. 
 

 
 
Modificación de contraventeos estructurales 
 
Con el comando Brace usamos vigas estructurales para su creación, por lo tanto, tenemos 
las mismas maneras de modificar una viga, como lo son> 
 

• Herramientas de ajuste manual. 
 

Los contraventeos cuentan con Beam Handles y Shape Handles para su ajuste manual. 
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• Ajuste de elevación  
 
Los contraventeos cuentan con el parámetro Start/End Attachment con el valor Distance 
por defecto, lo cual los hará ajustarse a cualquier cambio que tenga el componente 
estructural al que esté ligado. 
 

 
 

• Justificación de geometría 
 
Los contraventeos tienen parámetros de justificación de posición, lo cual los hará 
cambiar con respecto a la línea de ubicación del contraventeo. 
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• Uso estructural 
 

Al crear un contraventeo este cuenta con un uso estructural definido como Other, este 
se puede visualizar en la paleta de propiedades al seleccionar el contraventeo.  
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Este valor se puede cambiar por dos opciones que vienen definidos en la 
herramienta: 
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Capítulo 5 
 

Armaduras estructurales 
 
Revit Structure permite añadir armaduras estructurales al modelo. Para esto se utiliza la 
herramienta Truss, que crea una armadura según los parámetros de la familia cargable que 
se desee utilizar o de una familia personalizada. 
 
Cargar armaduras estructurales. 

1. Escoger pestaña Structure => Panel Component  => Load Family . 
2. En biblioteca de familias buscar categoría Structural Trusses => Seleccionar la 

familia deseada=> Open 
 

 
 
Componentes de una armadura estructural 
 
Las armaduras estructurales tienen una característica importante: están constituidas por 
líneas de diseño, las cuales representan el diseño geométrico que tiene la armadura. 
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Cuando se modela una armadura estructural, se crean vigas estructurales que se colocan 
en las líneas de diseño.  
Las líneas de diseño de la armadura dan una referencia de los subcomponentes que tiene 
la armadura: Cuerda Superior, Cuerda Inferior, Montantes y Diagonales. 

 
 

Al crearse vigas en las líneas de diseño estas adquieren un uso estructural especifico de 
acuerdo con el subcomponente al que hacen referencia, estos pueden ser: 
 

Chord Cuerda Inferior y Superior 

Wed Montantes y Diagonales 

 
Colocación de armaduras estructurales 

1. Escoger pestaña Structure=> Panel Structure=> Truss  . 
 

Al iniciar el comando se activará un panel en la pestaña llamada Place Truss, en 
este se encontrará la opción para cargar una nueva familia de armadura estructural, 
los métodos de colocación de armadura estructural. 
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En la barra de Draw el programa nos permite escoger un método de boceto para dibujar las 
armaduras los cuales son dos: 
 

• Pick lines 

• Lines 
 
Para colocar la armadura: 
 

1. Iniciar comando de Truss. 
2. Escoger pestaña Modify=> Panel Draw=> seleccionar la opción Line. 
3. En la barra de propiedades seleccionar el tipo de armadura que se desea usar. 

 

 
 

4. Se desplegará una barra de opciones para poder elegir el nivel en el cual se 
modelará la armadura. 
 

 
 

5. Colocar la armadura. 
La creación de las armaduras es muy similar a la colocación de vigas. Se necesita 
colocar un punto inicial y un punto final. 
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Modificación de armaduras estructurales 
 
Propiedades de instancia 
 
En la paleta de propiedades podemos encontrar parámetros que nos ayudaran a modificar 
la armadura. 
 

• Crear Cuerda Superior o inferior.  
 
Esta herramienta permite remover las vigas que pertenecen a la armadura. 

 

 
 

• Rotación. 
 
Los parámetros Rotation Angle y Rotation Chords with Truss nos ayudad a rotar la 
armadura y a definir la posición de las vigas que componen la cuerda superior e 
inferior.  
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• Altura 
 
Especifica la distancia entre las líneas de diseño inferior y superior en la familia de 
la armadura estructural. 

 

 
 
Propiedades de tipo 
 
En las propiedades de tipo se encontrarán parámetros que ayudan con la definición del 
comportamiento analítico, así como un parámetro para seleccionar el tipo de perfil (viga) se 
usara en la armadura. Estos parámetros están separados de acuerdo con el 
subcomponente que afecta. 
 

• Tipo de viga estructural 
En el cuadro de diálogo Propiedades de tipo, podemos encontrar el parámetro 
Structural Framing Type, este estará en cada subcomponente que se crea con la 
armadura. 
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Al desplegar el valor del parámetro, nos desplegara un menú de opciones con todas 
las vigas que se encuentren cargadas dentro del proyecto. 
 

 
 

Al seleccionar la viga que afectara al subcomponente de la armadura, es necesario 
dar clic en el botón OK o Apply para ver los cambios en el modelo. 
 

Editar perfil de armadura 
 
Revit Structure permite modificar las líneas de perfil de la cuerda superior e inferior para 
crear nuevas líneas, cambiar la forma del perfil y eliminar las que no necesitemos. 
 
Para modificar el perfil de una armadura. 
 

1. Se debe visualizar el componente que se desee editar desde una vista en sección 
o un 3D=> Seleccionar la armadura. 
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2. Selecccionar pestaña Modify=> Panel Mode=> Edit Profile. 
 

 
 

Al activar comando, las líneas de diseño de la Cuerda Superior y la Cuerda Inferior 
adquieren una simbología. 

 

 
3. Seleccionar la línea de diseño que se quiera editar. 

 
 Pestaña Editar Perfil=> Panel Draw=> Seleccionar el perfil que se desee editar 
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4. Seleccionar la herramienta de dibujo para realizar un boceto del perfil=> Eliminar la 
línea de diseño anterior. 

 
5. Finalizar el comando Editar Perfil 

 
 

Adaptar armadura a losa o cubierta 
 
Si el proyecto cuenta con geometría complejas en cubierta o con losas inclinadas, las 
armaduras se pueden adaptar a la forma que tengan estos componentes. 
 
Para adaptar la armadura: 
 
IMPORTANTE: Para poder adaptar la forma de la armadura es necesario tener creada la 
losa con la forma que se desee. 
 

1. Seleccionar armadura=> Pestaña Modify=> Panel Modify Truss=> Attach 
Top/Bottom. 
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2. Seleccionar losa a la cual se vaya a adaptar la armadura=> Finalizar 

 

 
 
 
Creación de una familia de Armadura Estructural 
 
Una familia de diseño de armadura se compone de líneas que definen elementos de 
armadura tales como diagonales y cuerdas. Las cuerdas y diagonales se crean de forma 
que sus ejes (eje local X) descansen a lo largo de las líneas de diseño que se definan en la 
familia de diseño de armadura. El diseño entero se transformará de forma que la distancia 
entre los dos planos de referencia final dependerá del ejemplar de viga de celosía según su 
forma en el proyecto. 
 
Selección de plantilla 

1. Desplegar File Tab  (Ficha de Archivo) => opción New => opción Family. 
2. Escoger la plantilla adecuada para columna estructural. => Open 
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Esta plantilla cuenta con parámetros específicos que ayudan a construir la familia 
de columna estructural. 

 
Dibujo de líneas de diseño. 
 

1. Pestaña Create=> Panel Detail=> Seleccionar el tipo de línea de diseño que se 
quiere trabajar. 

 
 

Las líneas de diseño definen los componentes que constituyen la armadura y se 
pueden identificar rápidamente con el color que tienen 

 
Top Chord Cuerda Superior 

Web Diagonales y Montantes 

Bottom Chord Cuerda Inferior 



130 
 

 
 

2. Una vez definidas las líneas de diseño, anclar los elementos a los planos de 
referencia. 
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Capítulo 6 
 

Losacero 
 
La losacero se crea mediante bocetos. Puede crear un boceto de líneas para los bordes de 
la losa seleccionando los muros o utilizando la herramienta Línea. Normalmente, se dibuja 
un boceto de un suelo en una vista de plano, aunque se puede hacer en una vista 3D, 
siempre que el plano de trabajo de la vista 3D se establezca en el plano de trabajo en el 
que se desea colocar el forjado estructural. 
La parte superior del forjado estructural se desfasa en relación con el nivel en el que se 
coloca. 
 
Colocación de losacero 
 
Para añadir una losacero: 
 

1. Escoger pestaña Structure=> Panel Structure=> Floor => Floor: Structural 

. 
Al iniciar el comando se activará un panel en la pestaña llamada Create Floor en 
este se encontrará la opción para crear el boceto del contorno de la losa.  
 

 
 

En la barra de Draw el programa nos permite escoger un método de boceto para 
dibujar las vigas entre los que podemos encontrar: 
  

• Línea recta. 

• Formas definidas. 

• Arco de inicio-fin-radio. 

• Arco de centro-punto final. 

• Arco tangente de punto final. 

• Arco de empalme. 

• Spline. 

• Elipse parcial. 
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2. En la barra de propiedades seleccionar la losa que se desea usar. 

 

 
 
3. Dibujar el contorno de la losa 
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4. Definir Span Direction. 
 
Es recomendable establecer la dirección de luz en las losas metálicas ya que de 
este depende la representación que tendrá en secciones. 

 
 

 
5. Finalizar comando de Floor. 
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Modificación de losacero 
 
Propiedades de instancia 
 
En la paleta de propiedades podemos encontrar parámetros que nos ayudaran a modificar 
la losa. 
 

• Nivel y tipo de recubrimiento. 
 
Dentro del panel de propiedades podemos modificar el nivel al que esta referenciada 
la losa y el tipo de recubrimiento que tendrá la losa para colocar armados 
estructurales. 

 
 

Propiedades de tipo 
 
Desde las propiedades de tipo, puede modificar el espesor de concreto y el tipo de perfil 
del metal deck  
 
IMPORTANTE: El tamaño del metal deck dependerá del tipo que seleccione. 
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Las familias de sistema para losacero tienen como característica primordial el uso de un 
Structural Metal Deck, el cual define el perfil de losacero que se representara en la losa. 
 
El Structural Deck se puede editar por medio de las Structural Deck Properties, aquí 
podemos seleccionar el perfil que tendrá el tipo de losa que estamos editando o el uso que 
tendrá este deck. 
 

 
 
 

• Metal Deck 
 

Para crear un Metal Deck personalizado: 
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1. Desplegar File => opción New => opción Family. 
2. Seleccionar plantilla Metric Profile 

 

 
 

3. Definir el uso de perfil en la paleta de propiedades. 
 

 
 

4. Trazar planos de referencia y cotas para controlar la parametriza del perfil. 
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5. Trazar el perfil con líneas de detalle.  
6. Guardar y cargar al proyecto que se esté trabajando. 

 
Voladizos 
 
La propiedad de voladizo de losa permite restringir el boceto de la losa a sus soportes y 
que su borde se extienda más allá de ellos. Los voladizos se aplican a las losas, antes o 
después de realizar el boceto de éstos. 
Los voladizos se crean ajustando dos parámetros de desfase que representan la capa de 
compresión de concreto y el acero de la lámina estructural. 
 

 
 
 
 
 
 
Para añadir un voladizo a una losacero: 
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1. Iniciar el comando Floor: Structural. 
2. Seleccionar el tipo de losa que se desee usar (Concrete with Metal Deck). 

 

 
 

3. Dibujar el contorno de losa.  
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4. Definir Span Direction. 

 
Es recomendable establecer la dirección de luz en las losas metálicas ya que de 
este depende la representación que tendrá en secciones. 

 
5. Seleccionar líneas de boceto. 

 
Al seleccionar una línea de boceto, estas tendrán un parámetro llamado Cantilevers 
el cual te permite modificar el voladizo que tendrá la losacero. 
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Este parámetro se podrá encontrar en la paleta de propiedades bajo el grupo Other 
y en una barra de propiedades en la parte superior. 
 

 
IMPORTANTE: cuando se trabaja con una losacero (Metal Deck) se habilita el parámetro 
Cantilevers Steel, si se trabaja con una losa que no contenga en sus propiedades un Metal 
Deck, este parámetro estará deshabilitado. 
 

6. Agregar un valor numérico a los parámetros Cantilevers=> Finalizar para conservar 
cambios. 

 

 
 
Al agregar un valor en el parámetro Cantilever Concrete, se creará una línea de bocete que 
representa la dimensión de concreto agregado. 
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Capítulo 7 
 

Conexiones estructurales 
 
En Revit Structure se pueden detallar las uniones de los componentes estructurales de 
acero por medio de familias cargables y la herramienta Structural Connections. 
 
Familias cargables de conexiones estructurales 
 
Revit cuenta con una librería de conexiones paramétricas para cargar los componentes. 
 
Cargar conexiones estructurales 

1. Escoger pestaña Structure => Panel Component  => Load Family . 
2. En biblioteca de familias buscar categoría Structural Connections => Seleccionar la 

carpeta Steel => Seleccionar la familia deseada. 
 

 
 
Colocación conexiones estructurales 

1. Escoger pestaña Structure => Panel Component  => En barra de 
propiedades escoger la familia de conexión deseada. 
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IMPORTANTE: Para que la colocación de la familia sea más precisa se recomienda tener 
una vista en planta y un alzado/sección que permita ver la altura donde se colocara la 
conexión. 
 

2. Colocar la familia de conexión.  

 
Al colocar la conexión en planta o alzado, se generará un forzado de cursor a los 
elementos estructurales cercanos, líneas de referencia, niveles y ejes para colocar 
la familia de manera precisa. 
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3. Ajustar la familia de conexión. 
 

Las conexiones cargadas desde las bibliotecas por defecto tienen parámetros que 
nos ayudan a ajustar la familia para que se acople a deferentes componentes 
estructurales. 
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Creación de familia de Conexión Estructural 
 
Revit permite crear una familia paramétrica personalizada desde el editor de familias, para 
esto es necesario tener las siguientes consideraciones: 
 

• No existe una plantilla de familia para Structural Connection, esta se generará 
desde una plantilla de Generic Model. 

• Es recomendable trabajar con familias anidadas. 
 
Para generar la conexión, se creará la familia de tornillo y posteriormente se trabajará la 
placa de ensamble. 
 
Creación de familia de tornillo: 
 

1. Desplegar File Tab  (Ficha de Archivo) => opción New => opción Family. 
2. Escoger la plantilla adecuada para viga estructural. => Open 

 
 

3. Cambiar la categoría de la plantilla por medio del icono Family Category  a 
Structural Connection. => Cambiar el Material for model behavior a Steel 
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4. Generar planos de referencia => Acotar. 
 

 
 
 

5. Crear parámetros y asignarlos a las cotas. 
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IMPORTANTE: para el ejemplo se utilizará la siguiente nomenclatura para crear 
los parámetros. 

 
Cabeza de tornillo= k 
Tuerca= k 
Extensión de tornillo= EX 
Separación de agarre= AG (nota este parámetro debe ser de instancia) 
Ancho de Cabeza de Tornillo= S 
Diámetro de tornillo= A 

 
 

6. Crear geometrías para tornillo => Restringir la extrusión a los planos de referencia 
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7. Asignar una subcategoría a las extrusiones. 
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Creación de familia de placa: 
 

1. Desplegar File => opción New => opción Family. 
2. Escoger la plantilla adecuada para viga estructural. => Open 

 
 

3. Cambiar la categoría de la plantilla por medio del icono Family Category  a 
Structural Connection. => Cambiar el Material for model behavior a Steel 
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4. Generar planos de referencia => Acotar. 
 

 
 

5. Crear parámetros y asignarlos a las cotas. 
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6. Crear geometrías para placa => Restringir la extrusión a los planos de referencia 
 

 
 
 

7. Asignar una subcategoría a las extrusiones => Plate 
8. Cargar la familia de Tornillo. 
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Pestaña Insert => Panel Load Family => Seleccionar familia de tornillo. 

 
 

9. Crear parámetro de longitud para el espesor del alma => Añadir formula.  
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10. Asociar parámetro de tornillo a “Espesor de alma” 
 

 
 

Seleccionar tornillo => En barra de propiedades seleccionar Associate Parameter 
=> Seleccionar parámetro Espesor de alma  

 
11. En una vista en planta generar planos de referencia para limitar la posición de los 

tornillos => Acotar planos de referencia => Generar un parámetro para controlar la 
distancia de la placa. 

 
 

12. Alinear el tornillo a plano de referencia superior => Restringir el tonillo al plano de 
referencia. 
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13. Generar un array a partir del tornillo => en la barra de propiedades seleccionar la 
opción Move to Last => Restringir el segundo tornillo a plano de referencia inferior. 
 

 
 

14. Crear parametro en array para controlar la cantidad de tornillos. 
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15. Acotar separacion entre tornillos => Crear parámetro para controlar distancia. 
 

 
 

16. Cuadro de dialogo Family Types => Parametro Altura => Generar parámetro para 
controlar la dimensión de la placa. 



155 
 

 
 
Conexiones de sistema 
 
Revit cuenta con una herramienta de conexiones estructurales el cual permite colocar 
conexiones parametricas  que se ajustan según los componentes estructurales a los que 
estan enlazadas.  
 
IMPORTANTE: Para poder utilizar esta herramienta es necesario instalar la actualizacion 
Steel Connections for Autodesk Revit 2020. 
 
Cargar conexiones estructurales de sistema 

1. Escoger pestaña Structure => Panel Connection  => Seleccionar botón 
Structural connection Settings. 

2. En el cuaro de dialogo apareceran las conexiones que se pueden cargar al 
prouecto y las que se encuentran actualmente cargadas. 
 

 
 

3. Seleccionar la conexión que se desee cargar al proyecto => Seleccionar la opción 
Add => Ok 
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IMPORTANTE: Si no se tiene la actualizacion o no se cargan las conexiones, la 
herramienta solo nos permitira colocar una conexión generica. 
 

 
 
 
Colocación conexiones estructurales 

1. Escoger pestaña Structure => Panel Connection  => En barra de 
propiedades escoger la familia de conexión genérica (Generic Connection). 

 



157 
 

 
 
 

2. Seleccionar los elementos que se deseen conectar => Con el teclado dar 
Enter/Barra espaciadora. 

 

 
 

3. Cambiar el orden de la conexión estructural. 
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La herramienta considera un orden de prioridad en los elementos estructurales, en 
una conexión estructural se considerara que existe un componente primario al cual 
se conectaran componentes secundarios 

 
En el ejemplo se consideta la columna como componente primario al cual se le 
conectara una viga como componente secundario. 
 

 
 

Para modificarlo se puede seleccionar el controlador con un circulo relleno 
(representa el componente primario) y arrastrarlo a la columna. 

 
4. Seleccionar el tipo de conexión desde la barra de propiedades. 
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IMPORTANTE: Para poder ver los componentes de las conexiones estructurales se 
deben seguir las siguientes consideraciones: 
 

• En el cuadro de dialogo de Visibility/Graphic Overrides se debe de encender la 
categoria Structural Connections y las respectivas subcategorias (apagadas en 
cualquier vista por defecto) 

 

 
 

• La vista en la que se deee visualizar las conexiones debe de tener un nivel de 
detalle Fine. 

 
Modificación de conexiones de sistema 
 
Cada tipo de conexión estructural tiene parametros que nos ayudan a modificar los 
elementos que la componen, por ejempo, la cantidad de pernos que tiene la conexión, las 
dimensiones de placas, los tipos de pernos, etc. 
 
Para este ejemplo se trabajara con la conexión Moment flange plates para describir las 
propiedades que tiene la conexión. 
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1. Seleccionar la conexión estructural => En la barra de propiedades desplegar el 

cuadro de dialogo Edit Tipe. 
 

 
 

2. Para poder modificar las caracteristicas de la conexión se debe seleccionar el 
parametro Modify Parameters. 

 

 
 

Este parametro desplegara un cuadro de dialogo que perimite personalizar la 
conexión estructural. 

 
En el caso de la conexión Moment flange plates permite personalizar: 
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